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Getting Started

Install the Connect Me Software 

To install Connect Me From a downloaded file
 Download the Connect Me Client from www.telecom.co.nz/connectme

 Navigate to the folder in which the Setup.exe file was saved

 Double click the Setup.exe file  

 Follow the on screen instructions 

To Install Connect Me From a 3G Mobile Device 
Some 3G mobile devices are capable of storing the Connect Me installer in 
their memory. If you have such a device and Connect Me has been pre-
loaded on the device by the manufacturer, the Connect Me installer will be 
launched the first time you connect the device to your computer. Just 
follow the instructions on screen to complete the installation. 

Launch Connect Me 
Once your hardware is installed and ready to connect, double click the 
Connect Me icon on your desktop.

To Uninstall Connect Me 

Windows Vista and Windows 7 
 Select Control Panel from the Windows Start menu

 Select Uninstall a Program from the Programs group 

 Select Connect Me from the list of applications that appears 

 Click Uninstall

Windows XP 
 Select Control Panel in the Windows Start menu

 Click Add or Remove Programs 

 Select Telecom NZ Connect Me from the list

 Click Remove

www.telecom.co.nz/connectme
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System Requirements

Windows XP Windows Vista Windows 7

Processor 300 MHz, 32 bit 1 GHz, 32 or 64 bit 1Ghz, 32 or 64 bit

RAM 256 MB 1 GB 1 GB 

Hard Drive 
Space

100 MB 120 MB 120 MB

Internet 
Explorer

IE 5.5 IE 7 IE 8

OS Service 
Pack

Service Pack 3 Service Pack 1 
(or above)

-

Additional Requirements:
 Windows Vista and Windows 7 requires a DirectX 9.0 (or better) 

graphics accelerator

 Internet Connection (if downloading the installer from the Internet)

 CD-ROM (if installing from CD)

 Compatible Wi-Fi device for wireless LAN connections

 Compatible 3G mobile (GSM) device for wireless WAN connections
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Know your Connection Manager

Select Connection Interface

Click these tabs to switch between the two versions of the main window:

Wi-Fi version

3G version

The Main Window: Wi-Fi Version

 You can do the following here: 

 Select different networks with Choose an Available Network

 Create and edit network profiles by selecting Options then Profiles

 Configure various user preferences settings by selecting Options and 
then Settings

 Connect/Disconnect from the network

 See how long you have been connected with the Connection Timer (you 
can hide this on the Application tab of the Settings window)

 See if you are connected to a Virtual Private Network (VPN) (this 
might not appear if your VPN client software is not supported by the 
Connect Me software)

 See how strong your signal is with the signal strength indicator
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Main Window: 3G Version

This window will display information about the status of your current 3G 
mobile connection (if any). 

You can do the following here:

 Connect Me should automatically select the TelecomNZ network or one 
of our roaming partner networks. Connect to establish a connection to 
the selected network

 Track your total data usage in Data Usage Indicator. The bar is green 
up to the monthly maximum for your data plan. Usage over your 
monthly maximum is shown in red. Clicking this indicator opens the
Usage Meter.

Note: This indicator does not appear until Usage Meter has been 
configured.

Note: The Connect Me usage meter is a guide only and does not 
accurately reflect your billed data. Always check the online usage meters 
at http://www.telecom.co.nz/homepage

 Create and edit network profiles by selecting Options and then 
Profiles

 Configure various user preference settings by selecting Options and 
then Settings

 Connect / Disconnect from the 3G mobile network

 See your connection status for currently selected network

 See how long you have been connected with the Connection Timer. 
When connected to a 3G mobile network, this indicates how long it has 
been since the connection was established. You can hide this on the 
Application tab of the Settings window

 The roaming indicator will appear if the currently-selected 3G mobile 
network is a roaming network. E.g. you are roaming off the TelecomNZ
home network if you connect to this. Consult your contract or 
http://www.telecomroaming.co.nz/support/data/ for more information 

http://www.telecom.co.nz/homepage
http://www.telecomroaming.co.nz/support/data/
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Controls for the Main Window
The buttons in the upper-right corner of the main window control the 
appearance and location of the window.

Reduce the window to an icon on the task bar at the bottom of the 
screen.

Display the mini bar version of the main window. Click  to 
return the window to full size.

Close the Connect Me application.

The Main Window: Mini Bar Version
This is useful when you want the Connect Me software to take up less 
space on screen. 

The Menu Bar

Connections ( = new messages) 

Options

Help

Self Service

Connections 
This provides various tools to enhance or provide information on your 
wireless connections. They include:

Messages. Click this to view and/or send messages in the Text 
Messaging Client. The number of new messages will appear to 
the right of this icon.

Mobile Info. This displays some technical information about the 
mobile network you are connected to (if any) and your current 
3G mobile device.

Wi-Fi Info. This displays some technical information about the 
Wi-Fi network you are connected to and your current Wi-Fi 
device.
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User Login. Opens a window that allows you to enter a standard 
user name and password combination as a default for certain Wi-
Fi connections. See Username and Password Logon Window
for more information.

To close the Connections Tray, click the Connections icon again.

The Options
This contains a number of options for configuring the Connect Me software 
and your wireless device(s):

Settings. Allows you to configure a number of personal 
preference options.

Profiles. Used to create and edit network profiles and to set 
their priority.

SIM Lock. Lock and unlock your 3G mobile device. See Locking 
and Unlocking Your Mobile Device for more information.

Help
This includes items which may answer questions or help with
troubleshooting problems.

Help. Opens the help system.

History Log. Opens the Advanced Tab of the Usage Meter. This 
is a troubleshooting tool that provides details on connections, 
disconnections and detection of new wireless devices.

Get Diagnostics. Generate a file containing diagnostics 
information. If you contact customer support, you may be asked 
to provide such a file to help troubleshoot any difficulties you 
may be having.

About. Contains version information for the Connect Me 
software.

Self Service
This provides a list options to give you one click access to online Self 
Service areas such as usage meters and prepaid top ups.

Prepaid Top Up. To top up prepaid mobile accounts.
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Your Telecom. To manage your accounts online. You can: 

- View your bills online

- Turn off your paper invoices and statements

- Get details of recent calls you’ve made

- Check your broadband usage

- Update your account details and email preferences

Usage Meter. To open the online prepaid usage meter

The System 
When Connect Me is running, it may place an icon like the examples 
shown below in the Windows system tray.

The Wi-Fi interface is selected.

The 3G interface is selected.

For either version of the icon, the number of green bars represents the 
strength of the signal being received from the currently-selected network.

 By clicking on this icon you can open the main window of the Connect 
Me software, if this is already open, you will move it in front of the 
other open applications. 

 Note: you can also right click and select show to do this.

 Right click on Help opens the help system

 Right click on Exit you can exit Connect Me

Automatic vs. Manual Connection
By default, Connect Me will automatically select an available network and 
establish a connection based on the priorities specified in the Network 
Profiles window. However, you can manually select a network if you 
wish. See the following topics for instructions:

 Manually Connecting to a 3G Mobile Network

 Manually Connecting to a Wi-Fi Network

If you manually connect to a network, it will disable the automatic 
connection for that technology type (e.g. 3G Mobile or Wi-Fi). If you wish 
to return to automatic connection mode, restart the Connect Me software.
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Establishing Mobile Connections

Manually Connecting to 3G Mobile Networks
Before you begin, you will need:

 A 3G mobile device capable of establishing connections. Windows 
device drivers for this device must be properly installed according to 
the manufacturer's instructions

 A valid Pre-paid or Post-Paid account with  TelecomNZ.

 A network profile configured to access  TelecomNZ (Connect Me creates 
these automatically when you connect a supported 3G mobile device)

Follow these steps to connect to a 3G mobile network:

 If you have not already done so, connect the device that you wish to 
use

 Select the 3G tab in the main window. If your device is properly 
connected and configured, the Connection Manager will search for an 
available network and select an appropriate network profile to use for 
the connection

 When Connect Me is ready, it will display the words ‘Ready to connect.’
Click Connect to establish a connection

Once connected, Connect Me will display a timer indicating the duration of 
the current connection.

Locking and Unlocking Your Mobile Device
You can lock your 3G mobile device to prevent it from being used by 
yourself or others. A locked device cannot be used to establish a 
connection.

Locking the Device
 Select Options and then SIM Lock in the menu bar

 Enter your current SIM PIN in the space provided

 Click OK to lock the device

Unlocking the Device
 Select Options and then SIM Lock in the menu bar

 Enter your current SIM PIN in the space provided

 Click OK to unlock the device
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PUK Codes
Devices sometimes have a limit to the number of incorrect PINs you can 
enter. This ranges from three to ten possible PIN entry attempts. If you 
fail to enter a correct PIN within the number of permitted attempts, a
window that allows you to enter a PUK Code appears.

Note: Depending on who you ask, PUK stands for either "Personal 
Unblocking Key" or "PIN Unlock Key." But, both names refer to the same 
code.

To enter a PUK code and reset your 3G mobile device's PIN:

 If you do not know your device's PUK code, contact technical support to 
obtain the correct code. The TelecomNZ default PUK code is '1234'

 If it is not already open, open the ‘Enter PUK and Change PIN Code’
window by selecting Options and selecting SIM Lock in the menu bar

 Type your PUK in the Current PUK Code box

 Enter your new PIN in both the New PIN Code and the Confirm New 
PIN Code boxes

 Click OK

Important: If you enter the PUK code ten times in a row incorrectly, 
your SIM will be disabled permanently.

To view information about your 3G mobile device or your current 3G 
mobile connection:

 Select Connections and then Mobile Info  in the menu bar

 The Mobile Info window provides useful information on your computer 
and your 3G mobile device

The Two Tabs in the Mobile Info window are:

Diagnostics: Device Tab
This tab contains detailed information about your device which is accessed 
via the driver installed on your computer. If the driver contains no 
information or information that is incorrect, it will be reflected in the 
appropriate field.

The information you will find in the Device Tab is as follows:

 OS (SP): The operating system currently installed on your computer 
and any service packs (updates) that have been installed for that 
operating system

 Port: The communications (COM) port that your wireless device is 
currently attached to

 Modem Manufacturer: The name of the manufacturer of your 
wireless device

 Modem Model: The model name of your wireless device

 Hardware ID: The hardware ID of your wireless device
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 Device Driver: The version of the driver for your wireless device 
currently installed on your computer

 Firmware Version: The version of your wireless device's onboard 
operating software

 Serial Number: Your wireless device's serial number

 IMSI#: A mobile subscriber's SIM is assigned a unique 15 digit IMSI 
(International Mobile Subscriber Identity) code. This allows any mobile 
network to know the home country and network of the subscriber

 IMEI#: International Mobile Equipment Identifier, a number string 
uniquely identifying a 3G mobile device

 Phone Number: The telephone number of your 3G mobile device

 Phone Battery Status: The status of your phone's battery

Diagnostics: Network Tab
The Network tab contains information about the mobile network you are 
currently connected to (if any).

 Network Type: The type of 3G mobile network you are connected to

 Network Name: The name of the 3G mobile carrier you are connected 
to

 Signal Strength (%): The strength of the signal being received from 
this network, as a percentage of a maximum possible signal strength

 Signal Strength (dBm): The strength of the signal being received 
from this network

 APN Used: The name of the access point to which you are connected

 Country: The country in which the network access point is located

 Status: Indicates whether you are currently connected or disconnected

 Data received during the session: The amount of data received over 
this connection since it was established (in bytes)

 Data sent during the session: The amount of data sent over this 
connection since it was established (in bytes)

 IP Address: The IP address you are using for this connection
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Establishing Wi-Fi Connections

Manually Connecting to a Wi-Fi Network
 Select the Wi-Fi tab in the main window

 If you have not already, connect your Wi-Fi device to your computer. If 
your device is properly connected and configured, Connect Me will 
begin searching for an available network. When Connect Me is ready, 
the button below the signal strength indicator will display the name of 
the network that has been selected

 Click Connect to access the selected network 

 To connect to a different network, click the button below the signal 
strength indicator. Then select the network you want to connect to

Note: To connect to a ‘closed’ item in the networks list, you must 
create a profile for that network. See ‘How to Access a Closed Network’.

Prompts
Connect Me will attempt to establish a connection to the selected network. 
You may see either one or both of the following prompts during this 
process:

 If the network is encrypted, you will be prompted to enter an 
encryption key. If you know the required encryption key, enter it and 
click OK. If you don't know the key for an encrypted network, you must 
click Cancel and select a different network. See How to access an 
encrypted network

 When connecting to a network for the first time, Connect Me may 
display the New Network Options prompt. Using this dialog box, you 
can configure Connect Me to automatically connect to a network in the 
future or to prompt you when that network is available

The List of Wi-Fi Networks
Clicking the button below the signal strength indicator in the Wi-Fi version 
of the main window opens the Wi-Fi networks list.

To connect to a network on the list either select the network and then click 
the Connect button or double-click on the network in the list. The 
information displayed for each network will include some (if not all) of the 
items shown below Right-clicking in the window will produce a menu that 
controls which columns are displayed
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 Connect: This column provides connection/disconnection buttons for 
each available network

 Preferred: A check mark is presented for any Wi-Fi network that is 
currently listed in the Network Profiles window. This includes network 
profiles that have been pre-defined by TelecomNZ, Wi-Fi networks for 
which you have created Network Profiles and Wi-Fi networks that you 
have already connected to (for which a profile was automatically 
created)

 Network: This is the Network Signal Set IDentifier (SSID) - essentially
just a name that is broadcast by a Wi-Fi access point to identify the 
network. If you see a ‘closed’ item in this column, this indicates the 
presence of one or more Closed networks. See ‘How to Access a Closed 
Network’

 Mode: two possible entries (shown below)

Indicates this network is in infrastructure mode. You will 
be connecting to a network through a dedicated 
wireless access point.

Indicates this network is in ad hoc mode. You will 
connect directly to another computer through its Wi-Fi 
device.

Note: You can share your Internet connection by 
hosting an ad hoc Wi-Fi network. See Hosting an Ad 
Hoc Connection for more information.

 BSSID: The MAC address of the Access Point’s Wireless Network 
Interface Card

 Channel: The channel on which the wireless network is broadcasting

 AP Vendor: The manufacturer of the wireless access point

 Encryption: Networks that are encrypted will have a dark gray padlock 
icon. See How to access an encrypted network for instructions on 
connecting to encrypted networks. Non-encrypted networks will have a 
lighter gray padlock and no accompanying text

 Signal Strength: A gauge showing the strength of the signal being 
broadcast from each network. Stronger signals tend to produce more
reliable connections

 Beacon Period: Wireless access points periodically broadcast a packet 
called a ‘beacon’ which helps to synchronize communications with 
connected systems. This number indicates how often (in milliseconds) 
the beacon is transmitted

 Supported Rates: A list of all the transmission rates supported by this 
network

 Time First Seen: The time of day when Connect Me first detected this 
network. This value represents the current session only. It will reset 
when you restart Connect Me
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 Time Last Seen: The time of day when Connect Me last detected this 
network

Wi-Fi Network List - Display Options
Right-clicking in the Wi-Fi networks list produces a menu that controls 
display options for the list. All of the items in the top section of this menu 
correspond to columns in the list of Wi-Fi networks. Checked and uncheck 
items to display or hide. 

Additional items in the menu:

 Show Closed Networks: When checked, Connect Me will indicate that 
one or more closed networks are present by displaying ‘closed’ in the 
Wi-Fi networks list. Removing the check from this item will suppress 
the indication 

 Consolidate Networks: When two or more hotspots are broadcasting 
the same network name they are almost certainly accessing the same 
network, so Connect Me normally only lists the hotspot with the 
strongest signal for any network. If you would prefer that all hotspots 
that broadcast the same network name are listed individually, remove 
the check

 Reset Columns: Select this to restore all the check marks in the top 
section of the menu to their default states

 Show All Columns: Select this to check all items in the top section of 
the menu

 Hide All Columns: Select this to uncheck all items in the top section of 
the menu

Options for Connecting to a New Network
If Prompt me before saving network settings is selected in the 
Automatic Profile Creation Settings window, a dialog box will offer four 
options each time you connect to a new network for the first time. The 
option selected specifies the type of profile that will be created for this 
network. By creating a profile automatically, Connect Me makes it easier 
for you to connect to the same network in the future. You must choose 
one of the following options:

 Automatically connect to network in future: The profile created 
will specify that Connect Me should automatically establish a connection 
to this network whenever it is detected

Note: When multiple networks configured for auto-connection are 
detected, Connect Me will choose which network to connect to based on 
the ranking of profiles in the ‘Network Profiles Window’

 Prompt me before connecting to this network: The profile created 
will specify that Connect Me should offer to connect to this network 
whenever it is detected

 Save settings for manual connections: The profile created will save 
the settings used to connect to this network. This allows Connect Me to 
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automate the details of establishing a connection to this network. You 
must still initiate connections to this network manually by selecting the 
network and then clicking the Connect button

 Do not save settings: You can connect to the network this time, but 
no settings will be saved for future connections (no profile will be 
created)

What is a Closed Network?
Closed networks are private networks that do not choose to broadcast 
their existence. Connect Me can detect when there are closed networks 
present simply because it ‘sees’ unidentified broadcasts in the Wi-Fi 
frequency band. When this happens, it will display ‘closed’ in the Wi-Fi 
networks list.

Note: Connect Me cannot detect the actual name of or establish a 
connection to a closed network unless you create a profile for that 
network. For more information, see How to create a Wi-Fi Network 
Profile.

How To Access a Closed Network
To access a closed network with Connect Me, you must set up a Profile
for that network:

 Select Options and then Profiles in the menu bar

 Select Add New Profile from the Settings menu

 Select Wi-Fi

 Click Add

 Enter the name of the network you want to add in the SSID field. The 
network name is case sensitive and must be entered exactly as 
provided by the administrator of the closed network you want to 
connect to

 Check the This is a non-broadcasted network (closed) box to 
identify this as a closed network

 Complete the remaining fields on this page as instructed by the 
administrator of the closed network

 Click Next to continue to the General page of the profile wizard. 
Configure the remaining fields as desired

 Click Finish

Wi-Fi Encryption

Introduction to Wi-Fi Encryption
Unlike a wired local network, a wireless network cannot easily be protected 
from potential intruders by physical barriers such as walls. Since radio 
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signals travel through physical objects, a potential intruder merely needs 
to have a look with the right equipment to see the traffic traveling across a 
wireless network. For this reason, wireless networks often employ 
encryption to protect their users. To access an encrypted network you will 
need the encryption key used by that network.

What is an Encryption Key?
An encryption key is a code key used to encrypt data exchanged between 
an encrypted network and Connect Me. You cannot exchange data with an 
encrypted network without having the appropriate encryption key.

The key for encrypted networks must be obtained from the administrator 
of the encrypted Wi-Fi Network you are trying to access.

How to Change an Encryption Key
When a network is added to the list in the Network Profiles window, all 
encryption information is saved with it. Therefore, you will not be asked 
for encryption information again when connecting. For security purposes, 
the network administrator may change the encryption key for the network. 
When this happens, you will need to update the key in the appropriate 
network profile to match the new key specified by the network 
administrator. Follow these steps:

 Select Options and then Profiles in the menu bar

 Select the network for which you wish to edit the encryption keys

 Click Edit

 Switch to the Wi-Fi tab

 Enter the new encryption key in both the Network Key box and the 
Confirm Network Key box

 Click OK

Wired Equivalent Privacy (WEP)
WEP was the standard encryption technology used in the early days of Wi-
Fi networks. More secure methods, such as WPA have since emerged, but 
WEP remains an extremely popular choice for encrypted networks. There 
are two variants of WEP:

 WEP Open: By far the most commonly used version of WEP. Networks 
that use this don't bother to verify that you have the correct 
encryption key before allowing you to connect - if you don't have the 
connect encryption key, you won't be able to communicate with the 
network anyway

 WEP Shared: Forces you to prove you have the correct encryption key 
before allowing you to connect, they do this by sending out sample text 
for Connect Me to encrypt. If the network gets back what it expects, it
will allow you to connect. Ironically, this is less secure than WEP Open 
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because the verification process used gives potential intruders useful 
information about the contents of the encryption key

Wi-Fi Protected Access (WPA and WPA2)
Wi-Fi Protected Access (WPA) is a key improvement over WEP for both 
businesses and home users. It was developed when an industry trade 
group known as the Wi-Fi Alliance became concerned that the security in 
the existing WEP standard was insufficient. They quickly issued an interim 
standard that would address most of their concerns while they developed a 
more complete final standard. The interim standard became known as 
WPA, while the final standard would be termed WPA2. To use WPA, you 
need a WPA-compliant Wi-Fi device.

What are TKIP and AES?
TKIP and AES are different encryption protocols that can be used with 
WPA. TKIP was used in the original WPA specification. AES, which is even 
more secure, was added as an alternate method to later versions of the 
specification. So, if the network uses WPA but doesn't specify which of 
these it uses, TKIP is the most likely to be supported by the network.

What Does "PSK" Stand For?
‘Pre-Shared Key’ - it simply means that the encryption key must be given 
to you by the administrator of the Wi-Fi network before you attempt to 
connect so that you are able to enter it when prompted to do so.

How to Access an Encrypted Network
The steps required to connect to an encrypted Wi-Fi network are the same 
as those required to connect to a non-encrypted Wi-Fi network — until you 
click Connect. When you click the Connect button, a dialog box will 
prompt you to enter a network encryption key. In order to proceed, you 
must enter the network encryption key obtained from the administrator of 
the network you are trying to access.

When you are finished, click Connect on the prompt dialog to proceed.

Note: If you create a profile for this network containing the appropriate 
encryption parameters, you will not see this dialog box when you attempt 
to connect after your initial connection.

Username and Password Logon Window
Selecting Connections and then User Login in the menu bar causes the 
Username and Password Logon window to appear. 

If your wireless data provider grants you access to certain pay or 
subscription Wi-Fi networks, the provider will typically give you a 
username and password to use when logging into such networks. If you 
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don’t want to enter that username and password each time you connect to 
such a network, you can specify them in this window.

Note: The username and password entered here will be used only for pay 
or subscription Wi-Fi networks that your wireless data provider grants you 
access to. It will not be used for other networks.

 Enter your user name in the Username box

 Enter your password in the Password box

 Enter your password again in the Confirm Password box

 Choose the Save option that best suits your needs:

 Save Nothing

 Save Username only

 Save Username and Password

 Click OK to save your entries and close the window, or click Cancel to 
discard your entries and close the window

Ad Hoc Connections

What is an Ad Hoc Network?
Ordinarily, Wi-Fi access to networks is provided by specialised devices 
called ‘Access Points.’ Access points communicate wirelessly with your 
computer's Wi-Fi device, granting you access to the network they are 
attached to.

However, end user Wi-Fi devices can also establish connections directly to 
one another rather than to a network access point. Such connections are 
called ‘ad hoc networks.’ Here, one computer becomes an ad hoc host, 
performing some of the actions that would normally be performed by the 
access point. Then, another end user device is able to establish a 
connection to the host computer.

Limitations & Security Issues
There are key limitations and security issues with Wi-Fi ad-hoc mode 
wireless networking:

 Wi-Fi devices in ad hoc mode (hosting or participating) offer minimal 
security against unwanted incoming connections. I.E. ad hoc Wi-Fi 
devices cannot disable SSID broadcasts the way infrastructure mode 
devices can. Attackers will have little difficulty connecting to your ad 
hoc device if they get within signal range

 Signal strength indications that are accessible when connected in 
infrastructure mode are unavailable to you when you are in ad hoc 
mode. So, you will face some difficulty when you reposition an ad hoc 
device to achieve a better signal

 The Wi-Fi networking standards (including 802.11g) require only that 
ad hoc mode communication supports 11 Mbps bandwidth. You should 
expect that Wi-Fi devices that support 54 Mbps or higher in 
infrastructure mode will drop back to a maximum of 11 Mbps when 
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changed to ad hoc mode. Thus ad hoc mode should generally be 
viewed as ‘slower’ than infrastructure mode

Hosting an Ad Hoc Connection
Hosting an ad hoc network allows you to share your computer’s Internet or 
other network connection with another computer over Wi-Fi. Establishing 
such a connection has three steps:

1. Creating an Ad Hoc Wi-Fi Network Profile

 Select Options and then Profiles in the menu bar

 Select Add New Profile from the Settings menu

 Select Wi-Fi

 Click Add

 In the SSID Field, enter the network name (SSID) you want your 
computer to broadcast

 Check This is a hosted ad-hoc network (Computer to Computer)

 Click the Advanced button

 Check Enable Internet Connection Sharing when this network 
connects

 Pull down the Select host connection to share menu and select the 
network connection you would like to share over Wi-Fi. If you are 
currently connected to a network, ‘Currently active Internet connection’
is listed at the top of this menu

 The remaining options correspond to the potential connections listed in 
the Network Connections window of Microsoft Windows operating 
systems. These will be displayed in roughly the following order:

- Wi-Fi and LAN connections

- 3G and dialup connections

- VPN connections

 Click OK

 Click Next

 Configure the settings on the General page as desired

 Click Finish

2. Using an Ad Hoc Profile
Once you have created a network profile to use for hosting an ad hoc 
connection, the profile will appear in both the list of Wi-Fi networks and 
the Network Profiles window. Select this profile in either of these lists 
and then click the corresponding Connect button to broadcast the 
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availability of the ad hoc network. Connect Me will indicate that it is 
connecting

3. Establish a Connection to an Ad Hoc Host
Once a host computer is broadcasting its availability for ad hoc Wi-Fi 
connections, you should be able to establish a connection to it using 
another computer that supports ad hoc Wi-Fi connections. Follow these 
instructions to establish a connection to such a host:

 Start the Connect Me software

 Select the Wi-Fi tab

 Click the button below the signal strength indicator

 Click the Connect button associated with the ad hoc host you wish to 
connect to

Note: Ad hoc hosts display a different icon to Wi-Fi and 3G mobile 
connections in the Mode column.

 When the connection has been established, Connect Me will indicate 
‘Connected’
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The Wi-Fi Info Window
Select Connections and then Wi-Fi Info in the menu bar to open a 
window with two tabs.

Wi-Fi Info: Device Tab
This tab contains information about the Wi-Fi device you are currently 
using.  

 Vendor description: Information about the manufacturer of your 
Wi-Fi device

 MAC address: The hardware address of the device. MAC (Media Access 
Control) addresses are unique number sequences assigned by the 
device's manufacturer and usually cannot be altered. These addresses 
are used for transferring data by hardware-level protocols such as 
Ethernet and 802.11. Higher level protocols such as the TCP/IP protocol 
suite used by the Internet have their own addressing schemes, but still 
rely on the hardware-level protocol for the transfer of data between 
individual nodes on a network

 Driver version: The version of the driver for the device currently 
installed on your computer

 Firmware version: The version of the device's on-board operating 
software

Wi-Fi Info: Network Tab
This tab displays your computer's current Wi-Fi network configuration and 
the amount of activity on your Wi-Fi connection.

 IP address: The Internet Protocol address your computer is using for 
the current network Wi-Fi connection. Ordinarily, the address displayed 
here is assigned only for the duration of the connection. It is most 
likely not permanently assigned to your computer

 Gateway: The address of the device that is responsible for routing all 
of your network traffic onto the Internet

 DNS server: The address of the server your computer is using to 
translate Internet addresses from text to numeric format and back. For 
example, your browser might use the DNS server to convert 
google.com to 66.102.7.147

 DHCP server: The address of the server that assigned your computer's 
network configuration for the current wireless connection

 WINS server: The address of the server (if any) that your computer is 
using to find the names of computers on a Windows network

 Activity: Displays the number of packets of data that your computer 
has sent and received over the Wi-Fi connection since it was 
established
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Text Messaging (SMS)

Short Message Service
Connect Me makes SMS simple by allowing the user to send and receive
messages from a familiar messaging client.

The Text Messaging Client
You can send and receive texts through Connect Me like you can on your 
phone. In fact, Connect Me integrates with the existing Text Messaging 
application on your phone (if using a phone as your modem).

To view text messages, select Connections, then Messages in the menu 
bar.

You will then be presented with a message viewing and composing 
application that should feel familiar to anyone accustomed to using popular 
e-mail software packages.

Viewing and Managing Messages

Receiving Text Messages
When you receive an e-mail or a text message, an envelope-shaped 
indicator will appear next to the Connections icon in the menu bar. The 
number next to the envelope indicates the number of new messages.

Once the text messaging window opens, a list of your messages will be 
displayed in the right-hand pane. Each message will be accompanied by 
one of the following icons:

An unread SMS message.

An SMS message that you have already read.

An unread e-mail message.

An e-mail message that you have already read.

Double-click on any message listed to view the complete message.

Updating Your Inbox
If your 3G mobile device is connected to your computer, Connect Me will 
automatically retrieve new messages from the device when launched. You 
can also update the contents of your Inbox with either of the following 
icons:



- 25 -

Send/Receive. Connect Me will transmit any unsent 
messages in your Outbox and query your wireless device for 
any new messages received. If new messages are present, 
they will be added to your Inbox.

Refresh. Connect Me will delete all messages in your Inbox 
and then copy all messages on your wireless device into the 
Inbox. Note that messages that are in your Inbox, but not 
also on your wireless device will be lost.

Using Text Messaging With Tethered Mobile Handsets
Connect Me can connect to phone handsets over a serial, USB, Bluetooth 
or IrDA connection. Connect Me will assume that these wireless devices 
are your primary viewing device for text messages. Therefore, it will not 
delete any message from the device just because you happen to read it in 
Connect Me's text messaging interface. However, when you delete a 
message in the text messaging interface, it will also be deleted from the 
handset.

If you use your handset to send and receive text messages when it is not 
attached to Connect Me, Connect Me's text messaging inbox may change 
when you reattach the handset.

Certain handsets are not able to send text messages during an active data 
connection. If a device does not support sending a text message while 
using an active data connection, the message will be queued for delivery 
as soon as the active data connection is released. This is typically when 
the user selects the Disconnect button. 

Note: Although Connect Me can communicate with a handset over a 
Bluetooth connection, it cannot perform Bluetooth pairing automatically 
(you will have to manually pair the computer and the handset).

Managing Text Messages
The text messaging client window provides a number of management 
functions that allow you to save and organize your incoming and outgoing 
messages including: 

Click this button or select Folders > New Folder from the File 
menu to create a new folder in which to store messages.

Click this button or select Folders > Delete Folder from the 
File menu to delete a folder you have created (and all the 
messages it contains).

Click this button or select Move to Folder from the Edit menu 
to move the selected message to another folder. Note that 
moving a message from the Inbox to another folder will not 
delete the message from your wireless device. Therefore, the 
message may re-appear in your Inbox if you re-import 
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messages from the device.

Click this button or select Copy to Folder from the Edit menu 
to place a copy of the selected message in another folder.

Click this button or select Delete Message from the Action 
menu to delete the selected message. Note that deleting a 
message from the Inbox will also delete it from your wireless 
device. (If your wireless device is not currently connected to 
your computer, the message will not be deleted from the 
device until the device is reconnected.)

Click this button or select Load from the File menu to return all 
folders (except the Inbox) to their state at the time of the last 
save operation. This is useful, for example, if you accidentally 
delete messages that you wanted to keep.

Click this button or select Save from the File menu to save the 
current state of all folders (except the Inbox). A Save operation 
is automatically performed whenever you close the text 
messaging client window.

Exporting Messages to a File
The content of your messages can be exported to a number of text and 
graphic file formats. Follow these steps:

 In the text messaging client window, select the message or messages 
you want to export. You can select multiple messages by holding down 
the Control key and clicking on each desired message or select a range 
of messages by clicking on one end of the range and holding down the
Shift key while clicking on the other end

 Select Import and Export from the File menu

 Select Export to File

 Click Next

 Select the file format to which you wish to export the selected 
messages

 Click Finish

Sending Text Messages
Before attempting to send or receive text messages, make sure your 3G 
mobile device is properly attached to your computer and registered with 
the 3G mobile network (Connect Me will indicate Ready or Connected).

Note: Connect Me can send text messages when the application is in 
Ready to Connect mode or when you are actively connected. Some 
networks, however, may not support sending and receiving text messages 
while you are actively connected.

To send a text message, do the following:
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 Click New in the text messaging window

 Add the mobile number of the person you wish to send a message to in 
the To field

 Type the message you wish to send

 Click Send

Using the Address Book
Connect Me includes an Address Book feature which can be used to 
manage phone numbers and addresses. You can open the address book 
either by clicking the To… button in the New Message window or by 
clicking on the icon below in the main text messaging interface:

The address book appears as shown below.

From here, you can do the following:

 Add a new address book entry by clicking the Add button

 Select an entry you want to edit and then click the Edit button

 Select an entry you want to delete and then click the Delete button

 If you opened the address book from the New Message window, 
selecting an address book entry and then clicking OK will copy the 
entries phone number to the To field in the new message window

Note: You can import address book entries stored on your mobile phone.

Accessing Your Device's Phone Book
You can import your 3G mobile device's phonebook entries into Connect 
Me and export the Connect Me address book to your wireless device. 

Importing Phonebook Entries
To import phonebook entries from your wireless device, click this icon:
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The address book entries from the handset will be added to Connect Me's 
address book. If an address is already in Connect Me's address book the 
imported entry will replace the existing entry. 

Exporting Address Book Entries
To export entries from Connect Me to your 3G mobile device, click this 
icon:

Important! This will replace the entire phonebook on your 3G mobile 
device. Anything in the device's phonebook prior to this action will be 
deleted.

Importing and Exporting Your Address Book
Connect Me can exchange address book information with a variety of 
sources including the phonebook on your wireless device and Personal 
Information Managers (PIMs) such as Microsoft Outlook and Lotus Notes.

Exchanging address book information with a PIM requires running the 
Import and Export Wizard:

 From the text messaging client window, select Import and Export
from the File menu

 Select Import from PIMs or Export to PIMs as desired

Note: the third option, ‘Export to File’, exports messages rather than the 
address book. See Exporting Messages to a File for more information.

 Click Next

 Select the software package you want to exchange address book 
information with

 Click Finish
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On Board Usage Meter
Displays Connect Me's approximate usage of your 3G mobile data plan. If 
desired, it can also monitor your total Wi-Fi usage. This should help you 
monitor roughly how much of your monthly data allotment has been used 
at any point in a billing period. 

To access this window: Select Connections and then Mobile Usage in 
the menu bar

Note: This meter should be used as a guide only and does not accurately 
reflect your billed data, always check the online usage by using the Self 
Service buttons that direct you to the meters on 
http://www.telecom.co.nz

Important! Usage Meter tracks only the portion of your data plan that is 
consumed by connections established with Connect Me. The totals 
displayed here will not include data usage that occurs when you connect 
via other applications.

To get started, you need to configure the Usage Meter in order to tell it 
about your plan maximum(s) and your monthly billing date.

Configuring the on board Usage Meter
In order for Usage Meter to report your usage, you must first tell it a little 
bit about your wireless plan(s):

 Open Usage Meter. Select Connections and then Mobile Usage in the 
menu bar

 Select your Billing period start date. This is the day of the month on 
which each billing period begins. You can find this on the monthly bill, 
online in Your Telecom or in the online Pre-paid usage meter 
http://www.telecom.co.nz/mbbmeter

 Using the Select Your Plan Limit menu, specify the monthly 
maximum data usage allowed by your 3G mobile data plan

 If your wireless data plan includes limits for Wi-Fi usage, select the 
Wi-Fi tab and repeat steps 2 and 3, this time include information about 
your Wi-Fi plan limits

Usage Meter: 3G & Wi-Fi Tab
These tabs of the Usage Meter show your 3G mobile and Wi-Fi data usage
respectively. 

Current Usage
The Current Usage section displays a graph of your overall 3G mobile data 
usage in the current billing period. The red line across the graph indicates 
the current monthly maximum specified in the Select Your Plan Limit
menu on the right. Usage below this limit is displayed in green. Usage 
beyond this limit is displayed in red.

http://www.telecom.co.nz
http://www.telecom.co.nz/mbbmeter
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Other items in this section include the following:

 Show usage for billing period: Once you have selected the start 
date for each monthly billing cycle (below), you can use this field to 
examine data usage for past billing periods. Select the billing period 
you want to view here. The relevant information will be displayed in the 
graph to the left

 Billing period start date: The day of the month on which each billing 
period begins. You can usually find this on the monthly statement, 
online in Your Telecom or in the online Pre-paid usage meter 
http://www.telecom.co.nz/mbbmeter

 Select Your Plan Limit: Specify the monthly maximum 3G mobile or 
Wi-Fi data usage allowed by your data plan

 Details: Display the Advanced tab of the Usage Meter with detailed, 
technical information about various Connect Me events (connections, 
disconnections, etc)

Cumulative Usage
The Cumulative Usage section displays a graph of your usage, separated 
into individual sessions. One bar will be displayed for each session. Items 
on this page include the following:

 Total Sessions: The number of sessions displayed in the graph

 Total Time Connected: The total combined connection time for all 
sessions displayed

 Reset Counter: Clears the display and resets the number of sessions 
to zero. This does not alter your overall usage, it just clears this 
cumulative usage graph so that you may more clearly examine the data 
for new sessions

 Details: Display the Advanced tab of the Usage Meter with detailed 
technical information about various Connect Me events (connections, 
disconnections, etc)

Last 12 Months
This displays a large graph of your usage over the last twelve months. 
There are no other items on the page.

Usage Meter: Advanced Tab
The Advanced tab of the Usage Meter is a troubleshooting tool that lists 
every Connect Me event (connections, disconnections, detections of new 
wireless devices, etc.)

 Double-click on any item in the list to see more information about that 
event

 Use the options in the Filter by box to limit the events displayed to a 
particular date range, connection technology or event type

http://www.telecom.co.nz/mbbmeter
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 Check your total combined usage for all events currently displayed by 
viewing the statistics at the bottom of the window

 Delete the record of the events displayed in this window by clicking the 
Clear Event Log button
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Virtual Private Networks (VPNs)
Virtual Private Networks (VPNs) are private networks that can be accessed 
over a public backbone network (like the Internet) without compromising 
their privacy. Typically, they maintain their privacy by forming secure 
(encrypted) ‘tunnels’ directly to the users who access them. For example, 
a company might set up a VPN for its employees to access the corporate 
network securely when they are away from the office.

The software responsible for forming the tunnel with the private network is 
called a VPN client. Because the VPN client and the private network 
exchange data in an encrypted format, no one on the public network over 
which this information passes can access it.

Supported VPN Clients
Connect Me currently supports the following VPN clients:

 Microsoft VPN Client

 Cisco VPN Client

Other VPN clients can be launched by Connect Me, but non-supported 
client software must be configured manually and its usage has some 
limitations. See Using a Non-Supported Client for more information.

Configuring a VPN Connection
The instructions below should be used for VPN client software that is 
supported by Connect Me. 

 Consult the administrator of the VPN you wish to access. They will 
provide you with VPN client software and instructions for establishing 
VPN connections using that software

 If the VPN client software is not already installed on your system, 
install it now. (Microsoft's VPN client is pre-installed on most versions 
of Windows)

 Open the Connect Me application

 Open the Settings window (Select Options and then Settings in the 
menu bar)

 Select the VPN tab

 Select Use existing VPN profile. Then, specify the client software and 
the login profile that you want to use

 Click OK

Once VPN settings have been configured, you can configure specific 
network profiles to automatically start a VPN session upon connection.
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Using a Non-Supported VPN Client
Connect Me can launch a VPN client that it doesn't support. However, its 
ability to work with these clients is very limited. Make sure you thoroughly 
read these procedures and the usage notes that follow before you attempt 
to use a non-supported VPN client with Connect Me.

Installing and Configuring the VPN Client Software
The first task in utilising unsupported VPN client software is to make sure 
that the VPN client is fully installed and configured to establish a 
connection to your VPN. All configuration of the VPN client software must 
be done from within the VPN client software itself. Connect Me cannot 
configure unsupported VPN clients. Work with the administrator of your 
VPN to achieve the following:

 If the VPN client software is not already installed on your system, 
install it now

 Configure all the necessary profiles and/or other settings necessary for 
logging into your VPN

 Determine the exact command line necessary to launch your VPN 
software and establish a connection to your VPN from the Windows 
command prompt. This must include any additional command line 
parameters that are necessary to successfully establish a connection

Important! If you cannot establish a VPN connection from the Windows 
command prompt, Connect Me will not be able to establish a connection 
using your VPN client software. Connect Me simply invokes the command 
line given to it. It has no other interaction with unsupported VPN clients.

Configuring Connect Me
When you can launch your VPN client and establish a VPN connection from 
the Windows command line, you are ready to configure Connect Me. 
Follow these steps:

 Open the Connect Me application

 Open the Settings window (Select Options then Settings in the menu 
bar)

 Select the VPN tab

 Select Use third party VPN client

 Click Browse

 Select the program file to be launched

 Click Open. The path of the selected file should now appear in the 
Command line field

 If the VPN client software requires that additional parameters be 
included after the program file name on the command line, enter these 
in the Parameters field

 Click OK
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Once VPN settings have been configured, you can configure specific 
network profiles to automatically start a VPN session upon connection.

Usage Notes
 Depending on which VPN client you are using, the VPN client may 

establish a connection automatically or require additional input 
(password or other credentials) from the user when launched

 Connect Me has no way of determining the status of VPN connections 
established by unsupported VPN clients. Therefore, the VPN indicator in 
the main window will not update correctly when used with an 
unsupported VPN client

 Be sure to shut down the VPN client software properly (according to the 
manufacturer's instructions) when you are finished with a VPN session. 
If the VPN client is not shut down properly, Connect Me may have 
trouble launching the software the next time it attempts to do so

 You cannot shut down the VPN client or its VPN connection from within 
Connect Me. You must work directly with the VPN client software

Automatically Launching a VPN Connection
You can configure any network profile to automatically connect to a Virtual 
Private Network whenever you connect using that profile:

 If you have not already done so, configure the connection settings for 
the VPN you wish to connect to

 Open the Network Profiles window. (Select Options then Profiles)

 In the left pane, select the profile for which you want to automate VPN 
connection

 Click Edit

 If the General tab is not already selected, select it now

 Check the Auto Launch box in the VPN section

 Click OK
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 Repeat steps 3 through 7 for any additional profiles that you want to 
auto-launch your VPN connection with

Note: If you want your VPN to be launched automatically with all (or 
most) of the new profiles you create, consider checking the Autolaunch
box on the VPN tab of the Settings Window. This configures the default 
behaviour of all newly created profiles.
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Creating and Managing Network 
Profiles
A network profile is a saved configuration for connecting to a particular 
network. Some profiles may have been pre-defined by TelecomNZ
Additional network profiles for other types of connections can be created in 
the Network Profiles window.

Creating Network Profiles has the following advantages:

 You can configure the client to automatically connect to a Network 
Profile whenever that network is available

 If the last network you connected to is not available at a particular 
location, the Connect Me will select a network from the list of network 
profiles in the main window (if one is available). This allows the same 
easy, one click connection to an alternate network

 You can automate steps in the connection process like entering an 
encryption key or logging into a VPN so that you don't have to perform 
these actions each time you connect

 Moreover, you must have a profile for the following:

 You cannot connect to a closed Wi-Fi network unless you create a 
‘closed network’ Network Profile

 You must have a network profile for each 3G mobile network that you 
wish to connect to. Often the Connection Manager will automatically 
create a profile when you connect a supported 3G mobile device

Creating and Importing Wi-Fi Profiles

Creating a Profile for a Wi-Fi Network
Follow these steps to create a Wi-Fi Network Profile.

 Select Options and then Profiles in the menu bar

 Select Add New Profile from the Settings menu

 Select Wi-Fi

 Click Add

 In the SSID field, enter the broadcast name of the network profile. 
Note that the name entered here must exactly match the SSID (Service 
Set IDentifier) used by the network

 If you are configuring a profile for a closed network, check This is a 
non-broadcast network

 If the network whose profile you are configuring does not use WEP or 
WPA encryption, the Enable data encryption box should remain 
unchecked and no further security configuration is necessary
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 If the network does use WEP or WPA encryption, check the Enable 
data encryption box and configure the Wi-Fi data encryption settings 
(see Enabling Wi-Fi Data Encryption)

 Click Next

 Configure the settings on the General page and then click Finish

Enabling Wi-Fi Data Encryption
 Check the Enable data encryption box

 Select the Authentication method used by this network. Supported
authentication methods include:

 None: Select if the network is unencrypted

 WEP-Open (Normal Method): This is the standard WEP encryption 
method

 WEP-Shared: Use this only if told by your network administrator

 WPA-PSK: You will need to enter your pre-shared key in the ‘Network 
key’ fields provided

 WPA2-PSK: You will need to enter your pre-shared key in the 
‘Network key’ fields provided

Note: The WPA methods will only be listed here if your current Wi-Fi 
adapter supports WPA security.

 Enter the encryption key for this network in Network key and 
Confirm network key fields

Automatic Profile Creation Settings
If you wish, Connect Me can automatically create network profiles for 
each new Wi-Fi network you successfully connect to. The setting that 
controls this can be found by selecting Wi-Fi Network Options from the
Settings menu in the Network Profiles window. The following options 
are available:

Automatically save all Networks that I connect to
Connect Me will create a new profile for every new Wi-Fi network you 
successfully connect to.

Prompt me before saving Network Settings
Connect Me will ask you if you want to create a new profile each time you 
successfully connect to a new network.

Allow manual input of network settings only
Connect Me will not automatically create a network profile.

Importing Wi-Fi Profiles From the Operating System
If you have established connections using the Wi-Fi Management tools 
built into the Windows operating system, Windows has probably created 
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profiles for the Wi-Fi networks you have connected to. You can import 
those profiles into Connect Me by doing the following:

 Select Options then Profiles in the menu bar

 Select Import Windows Wi-Fi Profiles from the Settings menu

How to Edit a Network Profile
Follow these steps to edit an existing network Profile: 

 Select Options then Profiles in the menu bar

 In the left pane, select the network you wish to edit

 Click the Edit button

Note: If the profile you are editing was created for you by TelecomNZ, you 
may not be allowed to edit some of its settings. If this is the case, certain 
tabs and/or settings may not be present.

 Make the desired changes

 Click OK

How to Remove a Network Profile
Follow these steps to remove a network from the Network Profiles window:

 Select Options then Profiles in the menu bar

 Select the network that you want to remove from the list in the left 
pane of the window

 Click Remove

 Click Close

The Network Profiles Window
This window can be used to add Network Profiles and to edit existing 
Network Profile settings. It can be reached by selecting Options then 
Profiles in the menu bar.
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Click on a portion of the screen shot below for more information on a 
particular item.

Profile Priorities
In the Network Profiles Window, profiles are listed in order of priority. 
When selecting a network to connect to, Connect Me will go down the list 
from top to bottom, selecting the first network profile for which all of the 
following are true:

 The network described by the profile is available

 You have a device that is ready and capable of connecting to the 
network connected to your computer

 The Connection Options field on the General tab in the profile's 
configuration is set to either ‘Automatic’ or ‘Prompt’

 The profile is not ‘Other Connections’

 Profile priority also determines when Connect Me will automatically 
switch from one network to another. If you are connected to one 
network and a higher priority network becomes available, Connect Me 
will switch to the higher priority network

Changing Profile Priority 
To change the priority of a specific profile, select the profile whose priority 
you would like to change. Then, click the Up or Down button to move the 
profile up or down the list.

Other Connections
Unlike the rest of the items in the network profiles list, ‘Other Connections’
is not a network profile. It is simply a placeholder for all network 
connections of types that are not managed by the Connect Me software. 
The placement of this item in the list determines how high priority these 
‘other’ connections should be considered. If ‘Other Connections’ appears 
higher in the list than your current connection and you connect a network 
of ‘other’ type to your computer, Connect Me will automatically shut down 
its current (lower priority) connection. 
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For example, if you had a local network connection of a type that is not 
managed by Connect Me and you wanted Connect Me to shut down any 
wireless connections it manages whenever you connected to your local 
network, you would simply move ‘Other Connections’ above all your 
wireless network profiles in the list. If, on the other hand, you did not want 
Connect Me to disconnect in this situation, you could leave it at the bottom 
of the list.

Note: you can specify which types of networks are included in the ‘Other 
Connections’ group in the Hardware tab of the Settings window.

Profile Icons
Each profile listed in the Network Profiles window will have an icon next 
to the name. This icon indicates the technology that this profile uses to 
establish connections.

3G mobile

Wi-Fi

Other - this is a placeholder for types of networks not 
managed by Connect Me. See Profile Priorities for more 
information

Profile List
This is the list of all the Network Profiles you have defined so far. Also 
listed here are any Network Profiles that have been pre-configured by 
TelecomNZ and any profiles that were automatically added when you first 
connected to a new network. 

A profile's position in the list indicates its priority. 

Profile Rank Buttons
Use these buttons to adjust the ranking of the network selected in the list 
above. Higher ranked networks (those that appear higher in the list) will 
be preferred above other networks in the list.

Connect Button
Connect to the currently selected Network Profile.

Profile Add Button
Add a new Network Profile to the list.
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Profile Remove Button
To remove a profile from the list, select it in the list above and then click 
this button.

Note: You cannot remove profiles that have been pre-configured by 
TelecomNZ

Profile Edit Button
To modify a Network Profile entry, select the Network Profile in the list 
above and then click this button. 

Network Profile Information
This box displays a quick summary of the information in the selected 
profile. 

Network Profile Information: Field Definitions
The fields displayed in the network profiles window may include the 
following:

Profile Name
This is the name of the Network Profile. If you have not named a Wi-Fi 
profile, this will be the SSID of the network.

Profile Type
This will show if the Profile was created by TelecomNZ (indicated by the 
word ‘Carrier’) or by you (indicated by ‘User’).

VPN
This indicates if a VPN connection is set to auto-launch when you establish 
a connection to this network.

Browser
This shows if you have your browser set to auto-launch a page and if you 
have proxy settings for this profile.

IP Address (3G Profiles Only)
This field indicates whether an IP address will be obtained automatically 
(using DHCP) or a fixed IP address has been specified.

DNS Server (3G Profiles Only)
This field indicates whether a DNS server address will be obtained 
automatically (using DHCP) or a fixed DNS server address has been 
specified.

Broadcast SSID (Wi-Fi Profiles Only)
This indicates whether this Wi-Fi network broadcasts its SSID. Networks 
that do not broadcast their SSID are called Closed Networks.
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Authentication (Wi-Fi Profiles Only)
This indicates the type of WEP or WPA authentication being used by a Wi-
Fi network.

Profile Properties: Mobile
This tab contains the 3G mobile - specific settings for Network Profiles. 

Service
The name of the network for which you are creating the profile. If this is a 
custom profile, you can specify the network name, otherwise the network 
name will have been entered for you (and will not be editable).

Service Type
Select the type of service provided by this network. The options include 
‘Packet’ for packet data (EDGE/GPRS type) connections and ‘Circuit’ for 
circuit-switched data (GSM/CSD type) connections. Note, if you have 
selected a network that only provides one type of service, this menu will 
only include the type that is provided by the selected network. 

Options include:

Dialled Number
Is the telephone number that your wireless device must dial in order to 
connect to the network. In most cases, the dialled number for the selected 
network will have been pre-entered for you (and will not be editable). If no 
dialled number has been entered, you must enter the appropriate number 
here. If you do not know the appropriate information for this network, 
contact TelecomNZ.

Access Point Name
The name of the wireless access point with which your 3G mobile device 
communicates when connected to this network. In most cases, the access 
point name for the selected network will have been pre-entered for you 
(and will not be editable). If no access point name has been entered, you 
must enter the appropriate number here. If you do not know the 
appropriate information for this network, contact TelecomNZ.

User Info
Your username and password for the network.
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Profile Properties: Wi-Fi
This window contains the security settings for Wi-Fi Network Profiles. 
Follow these steps to configure Wi-Fi network security.

 In the SSID field, enter the broadcast name of the network profile. 
Note that the name entered here must match the SSID (Service Set 
IDentifier) used by the network exactly

 If the network you are configuring is a closed network, check This is a 
non-broadcast network

 Ordinarily, This is a hosted ad hoc network (Computer to 
Computer) should remain unchecked

 If you want to use this profile to host an ad hoc network connection, 
you would check this box and then click Advanced to configure 
additional properties related to hosting ad hoc Wi-Fi connections

 If the network whose profile you are configuring does not use WEP or 
WPA encryption, the Enable data encryption box should remain 
unchecked and no further security configuration is necessary

 If the network does use WEP or WPA encryption, check the Enable 
data encryption box and configure the Wi-Fi data encryption settings

Profile Properties: IP Settings
The IP Settings page allows you to configure the Internet Protocol (IP) 
address to be used with this Profile. You will not need to alter these values 
unless specifically instructed by your administrator.

Profile IP Address
The top group of settings specify the IP address that your system will use 
when connected to this network. The default selection, Obtain IP 
address automatically, instructs Connect Me to ask the network to 
assign it an appropriate address each time it connects. This is the correct 
setting for most network profiles.

If the network does not support automatic address assignment, you can 
enter appropriate values manually by clicking Use the following IP 
address. Contact the administrator of the network whose profile you are 
configuring to obtain appropriate values for these fields.

Profile DNS server
This lower group of settings specifies the address of the name server that 
your system should use to translate names (e.g. "smithmicro.com") to 
numerical addresses when connected to this network. The default 
selection, Obtain DNS server address automatically, instructs Connect 
Me to ask the network to provide the address of a name server each time 
it connects. This is the correct setting for most network profiles.

If the network does not support automatic DNS server assignment, you 
can enter appropriate values manually by clicking Use the following DNS 
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server address. Contact the administrator of the network whose profile 
you are configuring to obtain appropriate values for these fields.

Alternately, click the Advanced button to configure detailed settings for 
DNS and WINS servers.

Advanced IP Settings
The Advanced IP Settings window appears when you click the Advanced
button on the IP Settings page of the network profile wizard. This window 
allows you to configure advanced settings pertaining to naming services 
and protocols to be used with a particular network profile. There are three 
tabs in this interface:

Advanced IP Settings: DNS Tab
This window allows you to configure the advanced settings pertaining to 
DNS server use.

DNS server addresses, in order of use
This is a list of DNS servers that may be used. The first listed will be tried 
first. The second server listed will be used if the first is not available, and 
so on. To add a server to the list, click the Add button and then enter the 
IP address of the desired server. If you wish to change the order in which 
servers are listed, use the arrows on the right.

Append primary and connection-specific DNS suffixes
Selecting this option specifies that when attempting to resolve an 
unqualified DNS name, your computer will send two different name 
resolution queries:

The first query it sends is based on the domain portion of your computer's 
name (which can be found by clicking on the System icon in the Control 
Panel). So, if the computer is looking to resolve the name "pc21" and the 
domain portion of your computer's name was "mycompany.com" the first 
query sent would be for "pc21.mycompany.com".

The second query sent is based on the DNS suffix entered in DNS suffix 
for this connection (below). So, if you entered "sales.mycompany.com" 
in that space, your computer would also attempt to resolve 
"pc21.sales.mycompany.com". This query is only sent if a DNS suffix is 
entered in the space provided.

The local setting is used only if the associated Group Policy is disabled or 
unspecified.

Append parent suffixes of the primary DNS
Checking this box specifies that your computer should also send queries 
based on the parent domains in your computer's name (up to the second 
level domain). For example, if your computer wants to resolve the name 
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"pc21" and its own name includes the domain "us.sales.mycompany.com",
it would query for "pc21.mycompany.com" and 
"pc21.sales.mycompany.com" in addition to the standard query for 
"pc21.us.sales.mycompany.com".

Append these DNS suffixes
Selecting this option specifies that when attempting to resolve unqualified 
DNS names, your computer will formulate a query based on each of the 
domains listed below. For example, if your computer wants to resolve the 
name "pc21" and the domains "sales.mycompany.com" and 
"mycompany.com" appear in the list, your computer will query for 
"pc21.sales.mycompany.com" and "pc21.mycompany.com".

The local setting is used only if the associated Group Policy is disabled or 
unspecified.

DNS suffix for this connection
If you wish to specify a DNS suffix for this connection, enter it here. If you 
enter a DNS suffix here, it will override any suffix assigned dynamically by 
a DHCP server. The local setting is used only if the associated group policy 
is disabled or ignored.

Register this connection's addresses in DNS
Checking this box specifies that this computer should attempt to 
dynamically register this connection's IP address (through DNS) using the 
full computer name specified on the Computer Name tab of the System 
applet Control Panel. The local setting is used only if the group policy is 
disabled or unspecified.

Use this connection's DNS suffix in DNS Registration
Specifies whether DNS dynamic update is used to register the IP addresses 
and the connection-specific domain name of this connection. The 
connection-specific domain name of this connection is the concatenation of 
the computer name (which is the first label of the full computer name) and 
the DNS suffix of this connection. The full computer name is specified on 
the Computer Name tab (available in System in Control Panel). If the 
‘Register this connection's addresses in DNS’ box is checked, this 
registration is in addition to the DNS registration of the full computer 
name. The local setting is used only if the associated group policy is 
disabled or ignored.

Advanced IP Settings: Protocols Tab
The Protocols tab of the Advanced IP Settings window lists additional 
protocols that may be used with this connection. Check the protocols that 
you wish to use.
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Advanced IP Settings: WINS Tab
The list of WINS servers on the WINS tab will be used to resolve NetBIOS 
names. To add a server to the list, click Add and then enter the IP address 
of the desired server.



- 47 -

Profile Properties: General
This tab contains settings that apply to all types of Network Profiles. 
Some of these options may not be available if you are configuring a profile 
created by TelecomNZ.

Profile Name
Enter a name for this network profile. This is how it will be displayed in the 
Network Profiles window.

Connection Options
This setting controls what Connect Me will do when it detects the network 
you are configuring. There are three options:

 Select Automatic if you want the Connect Me to automatically connect 
to this network whenever it is detected

 Select Prompt me if you want the Connect Me to ask you whether to 
connect to this network each time the network is detected

 Select Manual if you only want to connect to this network manually 

VPN Auto Launch
Check this box if you would like to automatically launch your VPN client 
software when you establish a connection to this network.

Enable Application Launcher
If this box is checked, the Connect Me software will launch the applications 
displayed on the App Launcher Tray whenever it establishes a 
connection to the network whose profile you are configuring.

If this box is not checked, the applications in the App Launcher Tray will 
not be launched.

Disable IE's Manual Proxy Settings...
If you normally connect to the Internet through a proxy server (this is 
common on corporate LANs), you may experience difficulty connecting to 
the Internet with Internet Explorer when you are travelling. This is 
because Internet Explorer is trying to connect through a proxy server that 
is on your home network rather than on the network to which you are 
connected.

If this is the case, you may wish to disable Internet Explorer's proxy 
settings while you are connected to other networks. Check this box to 
disable proxy settings while you are connected using this profile. 

If you wish to configure specific proxy settings to be used with this 
connection, click the Settings button.
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Launch Browser Window on Connect
Check this box to automatically launch your browser each time you 
connect to this network. If you want the browser to start at a particular 
web page each time you connect to this network, enter the address of the 
desired web page in the box below.

Proxy Settings
The proxy settings window is used to configure settings for Internet 
Explorer that will be used only for connections via the profile being created 
or edited. Primarily, this window is used to specify a proxy server that will 
be used for the connection. A proxy server acts as an intermediary 
between your local network and the Internet, forwarding requests for web 
pages and other data from individual users to the Internet. This allows the 
computers on the local network to remain largely invisible to external 
parties, rendering those computers somewhat less vulnerable to malicious 
attack.

Note: Automatic settings in the top section of this window override any 
manually specified proxy server in the lower section. If you want to 
manually specify a proxy server, make sure the top two boxes remain 
unchecked.

Automatically detect settings
If this box is checked, your browser will automatically detect proxy servers
and other configuration settings used to connect to the Internet.

Automatic configuration settings are contained in a file provided by your 
network administrator.

Use Automatic configuration script
Check this box if your browser should use configuration information 
contained in a file provided by your network administrator. The file might 
include settings for options such as what home page to use or 
configuration settings for the proxy server.

Use the Address space below to enter either the filename or a URL for the 
file you wish to use.

Use a proxy server for this connection
Check this box if you want your browser to use a proxy server when 
accessing the Internet. Then enter the address and TCP port number of 
the proxy server through which you wish to connect in the spaces 
provided.

Click the Advanced button to access more detailed settings for this proxy 
server.
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Bypass proxy server for local addresses
Because a proxy server acts as a security barrier between your local 
network and the rest of the Internet, you may not actually need it when 
accessing other computers on your local network. Checking this box allows 
you to avoid using the proxy server in these cases.

Proxy Settings: Advanced
The Advanced Proxy Settings window allows you to configure detailed 
proxy server settings. There are two groups of settings here:

Servers
If you want to specify separate proxy servers for each protocol, enter the
addresses and port numbers of the servers you wish to use here. 
Otherwise, check the Use the same proxy server for all protocols box.

Exceptions
Provides a space for you to type the web addresses that do not need to be 
accessed through your proxy server. 

If you want to connect to a computer on your local network, type its 
address in this box. For example, type "joe1" if you want to access a 
computer named joe1.

You can use wild cards to match domain and host names or addresses—for 
example, www.*.com, 128*, *.mygroup.* and so on. 

www.*.com,
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Connection Manager Settings

Accessing the Settings Window
The Settings window allows you to configure the behaviour of the Connect 
Me software. Among other things, these settings control how the client 
connects to networks, the sounds it produces and when it retrieves 
updates.

In the menu bar, click Options then Settings.

Settings: Application
The Application tab contains general settings for the Connect Me software. 
The following options are available:

User interface is always on top
Connect Me will always appear on top of other application windows.

Enable splash screen
Connect Me will display a splash screen while it starts up.

Automatically run this application on machine start-up
Connect Me will be launched automatically each time you start your 
computer.

Display connection timer
This box controls whether the connection timer will be displayed in the 
main window. When the box is checked (default), the timer will be 
displayed. When the box is unchecked, the timer will not appear.

Use this as my default Wi-Fi management utility
This box enables and disables Connect Me's Wi-Fi capabilities. When this 
box is not checked, Wi-Fi functionality is disabled and does not appear in 
the Connect Me user interface. This is useful if you have another Wi-Fi 
management utility that you would rather use instead of Connect Me.

Start in minimized mode
Connect Me will start in a minimized mode. Only Connect Me's System 
Tray Icon will be visible. Double-click the System Tray Icon to return 
Connect Me to view.



- 51 -

Hide application after connect
If this box is checked, Connect Me will hide itself once you are connected. 
Only Connect Me's System Tray Icon will be visible. Double-click the 
System Tray Icon to return Connect Me to view.

Show application on device insertion
If this box is checked, Connect Me will return to full size (after being 
minimized) when you attach your 3G mobile device. 

Transparency
This menu allows you to increase the transparency of Connect Me's main 
window.

Zoom
This menu lets you stretch the main user interface up to twice its default 
size.

Reset all warning messages
Connect Me provides various warning messages that can be disabled if you 
do not want to see them (typically, this involves checking a ‘Do not show 
me this message again’ box). You can turn all of these warning messages 
back on by clicking the Reset button.

Disable SMS Toaster
Check this box if you want to suppress the popup message that appears 
when you receive a new SMS message.

Settings: Connection Timeout
The settings on the Connection Timeout tab allow you to specify if and 
when Connect Me will automatically shut down a connection.

Configuring Duration Timeouts
A duration timeout is simply a maximum time allowed for any connection. 
So, if you specify a duration timeout of 30 minutes, any connection that 
lasts 30 minutes will be shut down.

To configure a duration timeout, check the Enable Duration Timeout
box. Then, specify the number of minutes after which the timeout should 
occur.

If you want Connect Me to warn you before it disconnects for a duration 
timeout, check Display warning before timeout.
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Configuring Inactivity Timeouts
Configuring an inactivity timeout instructs Connect Me to disconnect if 
there has been little or no data exchanged on a connection for a specified 
number of minutes.

To configure an inactivity timeout, check the Enable Inactivity Timeout
box. Then, specify the number of minutes of inactivity that will trigger the 
timeout.

Settings: Hardware
The Hardware tab is used to configure hardware-related settings for 
establishing connections. The following items can be found on this tab:

The Device List
This four-column table takes up most of the tab's area. It is a list of all the 
devices connected to your computer that may be used to establish 
network connections. From the device list, you can:

 Enable and disable individual devices

 Choose from multiple devices of the same type

 Configure extended properties for mobile broadband devices

 Change other settings and functions for connected devices

Device Priority
If there are two or more devices within a technology type and Automatic
is selected in the Selection column, Connect Me will choose the device that 
is listed first in the Device List. If that device is not currently connected to 
your computer, it will choose the next device in the list and so on.

To change the order in which devices are listed within their technology 
type, select a device whose position you wish to change and then click 
either the Up or Down button.

Note: This does not allow you to prioritise a Wi-Fi device over a 3G mobile 
device or vice versa. This type of prioritisation is done by individual 
network in the Network Profiles Window.

Allow simultaneous connections
If this box is checked, Connect Me will allow you to establish more than 
one connection at a time. (You could be connected to both Wi-Fi and 3G 
mobile at the same time.)

If this box is NOT checked, Connect Me will prompt you to disconnect 
before allowing you to establish a second connection.

Note: Some VPN connections may be seen as separate connections by the 
Connect Me software. If the Allow simultaneous connections box is 
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NOT checked, you may see a "’Multiple Connections Not Allowed’ error 
message if you try to make such a VPN connection.

Prompt before switching connections
When in automatic connection mode, the Connect Me software can 
automatically switch to a higher priority network if one becomes 
available. However, since the original connection is shut down once the 
new connection is fully established, this has the potential to disrupt any 
activity that was relying on the original connection.

If this box is checked, Connect Me will prompt you for permission to switch 
networks before it actually does so.

Profiles
Click this button to open the Network Profiles Window.

The Device List
The device list is a four-column table that appears at the top of the 
Hardware tab of the Settings window. It is primarily used to select and 
configure connected devices.
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Devices Column
This column lists all the network access devices installed on your 
computer, grouped by the connection technologies they use. Each 
technology type heading is followed by the names of the specific devices of 
that type that are installed on your computer. The technology types are:

 Mobile Devices

 Wi-Fi Devices

 Other Devices

Note: The configuration options for the ‘Other Devices’ group are 
significantly different to the other groups. 

Selection Column
This column allows you to specify which devices should be used to 
connect. The choices for this column are:

 Automatic: Connect Me will automatically choose the best device for 
this technology type

 Disabled: This option is necessary for some multi-function devices that 
can connect to only one type of network at a time. For example, you 
may have a Wi-Fi/3G mobile network adapter that can't access both 
types of network simultaneously. When using such an adapter, you 
may have to temporarily shut down Connect Me's access to one of 
these modes when you wish to use the other mode

 Manual: You can manually select the device to be used. After selecting 
this option, check the box for the device you wish to use

Status Column
This column identifies the operational status of the device (on or off).

Settings Column
3G mobile devices have additional properties that may be configured. Click 
the Modify button that appears in this column to configure those 
additional properties. This opens the Device Properties window. 

Other Devices
Unlike other categories in the device list, Other Devices lists devices that 
are NOT supported by Connect Me. Although Connect Me cannot use these 
devices to establish connections, it can detect when a device in this 
category has established a connection and (if you desire) shut down its 
own connections when this occurs. 

To monitor the connection status of a device in this group, check the box 
in the Selected column. If you want Connect Me to shut down its own 
connections when one of these devices establishes a connection, make 
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sure the Other Connections profile in the Network Profiles Window has 
a high priority.

The Automatic/Manual/Disabled dropdown menu at the top of the 
Other Devices group must be set to Manual to change which devices are 
checked. This menu also determines the default state of the checkbox for 
newly-detected devices:

 If the dropdown is set to Automatic, new devices added to the other 
group will be checked by default

 If the dropdown is set to Manual, new devices will be unchecked by 
default

Device Properties Window
This window contains additional configuration for 3G mobile devices. 

Network Selection
The settings in this section control how Connect Me selects which wireless 
network to connect to when you are travelling internationally.

 Automatic: instructs Connect Me to automatically select the best 
network to connect to, based on information provided by TelecomNZ. 
In most cases, this will provide the best connection available. This 
option is strongly recommended for all but the most advanced users

 Manual: instructs Connect Me to always connect to a specified network 
regardless of the availability of other wireless telephone networks. This 
is useful if you know of a specific network that always provides you 
better service and you are willing to put up with occasional service 
outages when the specified network is unavailable

Note: When manually scanning for networks, Connect Me currently 
displays all mobile networks in the area. Some networks displayed may 
not allow you to connect. For this reason, manual network selection is not 
recommended at this time.

Roaming Selection
The selected option here dictates whether Connect Me will attempt to 
establish connection to a roaming network:

 Always: Connect Me will always connect to roaming networks if the 
home network is not available

 Prompt: Connect Me will prompt to confirm before it attempts to 
connect to a roaming network

Connection Type
This group determines which software interface Connect Me should use to 
communicate with your 3G mobile device.

 NDIS allows more efficient communication with devices that support it
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 RAS is supported by more devices

Note: Many devices support only one of these interfaces. If this is the case 
with your device, the interface that your device supports will be selected 
by default and you will not be able to change the selection.

Settings: Sounds
The Sounds tab allows you to configure Connect Me to play a sound when 
various events occur. You can also specify the sounds that Connect Me 
plays. To enable this feature, check the Enable sounds box. Once the 
feature is enabled, checking the box for an event you wish to associate 
with a sound, and then click Browse to select the sound file that you wish 
to play (a Windows .WAV file). You can specify sounds for the following 
events:

Connected
When Connect Me successfully connects to a wireless network.

Lost Connection
When Connect Me disconnects from or loses its connection to a wireless 
network.

Hotspot Authentication
When Connect Me associates with and connects to a Wi-Fi hotspot.

Settings: Updates
The Updates tab allows you to specify how often (if ever) Connect Me 
attempts to retrieve updates to its software and its databases.

Update Now
Clicking this button results in Connect Me immediately checking for 
available updates. If new updates are available, an update wizard will 
appear. This wizard allows you to choose which updates you want to 
download and install.

Apply Firmware Update
As part of its update process, Connect Me can download updates to your 
3G mobile device's firmware. Normally, such an update will be installed as 
soon as it is downloaded. In some cases, however, you can choose to 
defer the update's installation until later. Click Apply Firmware Update
to install an update that you had earlier chosen to defer.

Note: This button does not appear unless you have uninstalled firmware 
updates for your current device.
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Automatically download and install
Select this option to have Connect Me automatically download and install 
product updates at regular intervals.

Note: Automatic updates are silent. You will not see the update wizard 
when updates are downloaded silently.

Prompt me to download and install
Select this option and enter an interval if you would like Connect Me to 
periodically prompt you to download and install product updates.

Manually download and install
Select this option if you want product updates to be downloaded only when 
you click the Update Now button.

Settings: VPN
The VPN tab specifies how Connect Me accesses Virtual Private 
Networks. The top item, Do not use VPN, disables Connect Me's 
capacity to log into VPNs. This is the correct setting if you do not wish to 
establish connections to VPNs.

You must choose one of the other two options and fill in the corresponding 
fields if you want Connect Me to automatically launch your VPN client 
software connection to specific networks. See Automatically Launching 
a VPN Connection for more about the VPN auto-launch feature.

Use existing VPN profile
Select this option if the VPN client software you will be using is supported
by Connect Me. Then, specify the supported VPN client software and the 
Login Profile that you want to use.

Use third party VPN client
Select this option if the VPN client software you will be using is NOT 
supported by Connect Me. Please read Using a Non-Supported VPN 
Client carefully and follow the configuration instructions when using an 
unsupported VPN client.

Auto Launch
Check this box if you want new network profiles created to automatically 
launch the VPN software specified above each time you connect. Note that 
this is only a default. You can change this setting for an individual profile 
by checking or un-checking the VPN Auto Launch box on the General tab 
of the properties for the desired profile. See Automatically Launching a 
VPN Connection for more information.
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Troubleshooting

By Error Number

Windows Numbered RRAS Errors Overview
The numbered errors that are displayed by Connect Me indicate that the 
Routing and Remote Access Service (RRAS) component of Microsoft 
Windows is having difficulty establishing or maintaining a 3G mobile 
connection set up by the Connect Me software. These errors are actually 
reported by the Windows Operating System. Connect Me merely displays 
them when they are received.

For troubleshooting instructions for the errors that are most commonly 
seen in Connect Me, find the appropriate error number below.

Error 619
This error is typically reported when attempting to connect to a 3G mobile 
network. It indicates a failure during the call setup.

Possible causes
 Network resources are unavailable

 Attempting to reconnect before your device has finished disconnecting 
from a previous call

 Your device may be malfunctioning

Resolution
Click the Cancel button in the main window and wait for Connect Me to 
display Ready to Connect. Then, try again. If you are still unable to 
connect, follow the steps below.

 Disconnect the 3G mobile device or tethered handset from your 
computer

 Restart your computer, while your computer is restarting:

 If using a tethered handset, power-cycle the device.

 If using a 3G mobile device with an external antenna, make sure the 
antenna is connected properly

 Open Connect Me and attempt to connect

 If you are still unable to connect, contact Technical Support

Error 628
The connection was terminated by the remote computer before it could be 
completed.
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Possible causes
 Call was dropped due to poor signal

 Call was dropped due to network congestion

Recommendation
 If indoors, move closer to a window, exterior wall or a higher level. 

Reorienting the computer or wireless device may help as well

 Wait 30 seconds and try to connect again

Error 630

Using a Phone Handset as Your Wireless Device
This error is typically reported when your phone or other wireless device 
has been removed or has not been properly set up. Make sure the device 
you are using for the current connection is properly attached to your 
computer. It may be necessary to verify the phone or device setup.

Using a PC Card as Your Wireless Device
This error is typically reported if:

 Connect Me has detected a hardware error in the PC Card

 The PC Card is not properly inserted. Make sure that the PC Card is 
secure in its slot

 The ‘Support SerialKey Devices Accessibility’ option is configured to use 
the COM port to which the modem is connected (see ‘Resolving Support 
SerialKey Devices’, below)

Try this first
 Click the Cancel button in the main window and wait for Connect Me to 

display Ready to Connect

 Try to connect again

 If this error appears again, turn your computer off and then back on

 Try to connect. If the error still appears, try the solutions listed below

Additional things to try
 Ensure that the modem is installed securely in its slot

 Try attaching the device to a different port (if one is available)

 Remove and reinsert the device to attempt the renegotiating of 
resources between the computer and modem

 Ensure that the device's drivers are shown in the Device Manager
with no errors

 Query the 3G mobile device to determine if the device is operating 
properly. See Querying a Wireless Modem for instructions

 Shut down all FAX and PDA software and launch Connect Me again. 
Some examples of common applications that can cause problems with 
Connect Me include: Palm Hotsync, Microsoft ActiveSync, and 
Blackberry Desktop Manager
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 Confirm and resolve any existing port conflicts

Resolving Support SerialKey Devices
For Windows XP, ensure that Support SerialKey Devices is not configured 
with the modem COM port:

 Click Start

 Select Control Panel

 Select Accessibility Options

 Click the General tab

 Uncheck the Use Serial Keys box

Error 631
This error is typically seen if you disconnect or cancel a 3G mobile 
connection prior to authentication occurring. In this case, the application is 
merely informing you that it did not expect you to disconnect at this stage. 
However, there is no actual failure. You should be able to reconnect at any 
time.

Error 633
Either the drivers for your wireless device are not functioning properly or 
some other program is locking the device.

Try These Quick Solutions First
 Try shutting down and unplugging the computer for one minute. 

Restart the computer and try to connect again

Note: If you are using an external wireless device to connect and that 
device has a separate power cord, once the computer has shut down, 
unplug the wireless device for one minute, plug the device back in, then 
turn on the device and restart your computer before attempting to connect 
again.

 Shut down all FAX and PDA software and launch Connect Me again. 
Some examples of common applications that can interfere with Connect 
Me include: Palm Hotsync, Microsoft ActiveSync, and Blackberry 
Desktop Manager

 Uninstall any other software that manages wireless connections, if 
present on the computer

Diagnosing More Complicated Causes
If the problem persists, query your 3G mobile device to see if it is 
responding properly. See Querying a Wireless Modem for instructions.

Error 634
This error is typically reported if an unexpected error has occurred while 
connecting to a Mobile network.
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Follow these steps to resolve this error:

 Verify that there is no default dialup connection selected in the 
Control Panel

 If you are still unable to connect, shut down your computer. Then, 
restart your computer and the Connect Me software

 Try to connect again

 If you are still unable to connect, reinstall the drivers for your wireless 
device. Refer to the user manual for your wireless device for 
instructions on reinstalling the drivers for your device and/or obtaining 
updates for the device's drivers

 If you are still unable to connect, your device may not be properly 
configured for data access. Contact TelecomNZ Technical Support

Error 635
This error may be reported if an unexpected error has occurred while you 
were connected to a 3G mobile network.

Resolution
 Click the Cancel button in the main window

 Optimise your signal strength: If indoors, move closer to a window, 
exterior wall or a higher level. Reorienting the computer/wireless 
device may help as well

 Wait for Connect Me to display Ready to Connect

 Try to connect again

Error 651
This error indicates a problem with the hardware driver being used. This 
error can manifest itself in two unique situations:

 An appropriate driver has become corrupted, or

 You are attempting to use an old driver with a modem firmware that 
requires a newer driver.

Resolution

 Disconnect the modem from your computer

 Uninstall and reinstall the driver hardware. Refer to the user manual for 
the device for instructions

 Verify that the device is installed correctly and it is responsive. See 
Querying a Wireless Modem for instructions

 Attempt to connect

 If the issue persists, download and install the latest version of Connect
Me

 If the error still persists, contact support personnel for the device or 
Connect Me Technical Support
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Error 668
This error indicates that the network connection was dropped.

Possible Causes
 Poor signal

 Network congestion

 You attempted to connect with a 3G mobile device that has not yet 
been activated

 Incorrect or missing Network Profile

Try These Solutions
 Optimise your signal strength: If indoors, move closer to a window, 

exterior wall or a higher level. Reorienting the computer/wireless 
device may help as well

 Reboot your computer and try again

 If your 3G mobile device has not yet been activated, contact Technical 
Support to activate it now

 Ensure that your 3G mobile data plan includes the type of access you 
are attempting. For assistance with rate plans, contact Technical 
Support

Advanced Troubleshooting
 Verify that the correct Network Profile is being used in Connect Me

 If no Network Profile is present, create a new profile, and then attempt 
to connect (see Creating a Profile for a 3G Mobile Network)

 If the issue persists, uninstall and reinstall the device drivers for the 
device. See the user manual for the device for instructions

 If you are still unable to connect, contact Technical Support

Error 678: There is No Answer
If you have previously established connections successfully using the same 
wireless device and connection profile, this problem is most likely because 
the device that answers your data call is temporarily out of service. This is 
a network problem, and it will most likely be addressed by TelecomNZ
shortly. Select a different connection profile to connect or try again later.

If you have not previously established a connection with this device, it 
may be a problem with your 3G mobile device's firmware. Verify that your 
device is using the latest version operating software offered by its 
manufacturer. If you have an alternative method of connecting to the 
Internet, you may be able to find links to the latest firmware for your 
device at the device manufacturer's web site.

Resolution
 Refer to the user manual for your device to obtain the manufacturer’s 

web site address

 Download and install the updated firmware
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 Reboot your computer

 Start the Connect Me client and try to connect

Error 679: Cannot Detect a Carrier
This error usually has one of the following causes:

 You are not using the correct connection profile to establish the 
connection or the connection profile you are using is not configured 
correctly. Try editing the network profile or selecting a different one

 Your device has not been properly provisioned for data access. Contact 
Technical Support for help

Error 680
This error typically occurs only when you are using an external wireless 
device (such as a phone) rather than a device that is built into your 
computer. It may have the following causes:

Another Program is using your Wireless Device
This error can appear if another program is already using your wireless 
device. Shut down any other programs that may be using your wireless 
device, and then try to connect.

Incorrect Device Selected in the Hardware Settings Tab
 Open the Settings window by clicking Options then Settings

 Select the Hardware tab

 Confirm that the device you are attempting to use is selected in the 
Selection column. (See The Device List for a description of all device 
options in the Hardware tab)

 If you are still unable to connect and are receiving this error, contact 
Technical Support

Error 691
This error may be reported if Connect Me has received an Authentication 
Error from a mobile network.

Possible causes
 Poor signal

 There is a problem with your wireless account credentials

Resolution
 Click the Cancel button in the main window

 Optimise your signal strength: If indoors, move closer to a window, 
exterior wall or a higher level. Reorienting the computer/wireless 
device may help as well

 Wait for Connect Me to display Ready to Connect
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 Try to connect again

 If the problem persists, contact Technical Support for help with 
resolving credential issues

Error 692
This error indicates that there was a hardware failure in the 3G mobile 
device. This error is typically reported if Connect Me has lost its connection 
with the device.

Resolution
 Click the Cancel button in the main window and wait for Connect Me to 

display Ready to Connect. Try to connect again

 If this problem continues to occur, close Connect Me. Then, restart the 
software and try to connect again

 If the problem persists and you are using an external device rather 
than a device built into your computer, disconnect the device from your 
computer and then reattach. Verify that the device is properly
connected to your computer. Try to connect again

 Ensure that any software provided by the device manufacturer, such as 
Nokia PC Suite or Motorola Mobile Phone Tools, has been disabled 
(refer to the user manual for the device). These programs can take 
control of the port that the device is attached to and Connect Me will be 
unable to connect to the device

 Uninstall and reinstall the device drivers (see the user manual for the 
device for instructions). Attempt to connect

 If the error persists, try resolving application conflicts

 If you are still unable to connect, contact Technical Support

Error 717
Connect Me was unable to obtain an IP address from the network. This is 
most likely only a one-time error.

Resolution
 Click the Cancel button in the main window

 Wait for Connect Me to display Ready to Connect

 Try to connect again

Error 718: Timeout Waiting for Valid Response from PPP Server
This error indicates that a PPP conversation was started but was 
terminated because the remote server did not respond within an 
appropriate time. This can be caused by several conditions including the 
following:
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Temporary Glitches and Services Outages
If you have not made any changes to your wireless device or its drivers 
since the last time you successfully connected, the problem is most likely 
caused by transient issues such as poor quality of the wireless signal or a 
temporary service outage.

 Try connecting again. In many cases, you will be able to immediately 
connect. If that does not work, restart Windows and try again

 Check the signal strength indicator for 3G mobile networks in the main 
window. If the signal strength is low, you may need to try a different
connection technology or a different network profile, or wait until you 
are in an area where you can get a better signal

 If you have good signal quality and trying again does not work, there is 
most likely some sort of temporary service outage.

Driver Issues
Although rare, it is possible that this error can be caused by a defective 
software driver for your wireless device. The best solution for this is simply 
to obtain and install the latest version of the driver from your device's 
manufacturer (refer to the user guide for the device).

TCP/IP Issues
This error may also occur if you do not have TCP/IP protocol enabled for 
the device that you are using to connect or if its TCP/IP settings are 
incorrect. Follow these steps to verify that TCP/IP is enabled:

 Select Control Panel > Network Properties (or Network and Dial-
Up Properties) in the Windows Start menu

 Right-click the connection corresponding to your wireless device, and 
select Properties from the context menu that appears

 Select the Networking tab

 In the list in the lower half of the window, make sure that Internet 
Protocol (TCP/IP) is present and that its box is checked. If not, click 
its check box

 Click OK

Personal Computer Firewall Issues
Personal firewall software on your computer may be configured to block 
Internet access— either generally or from specific connections. Make sure 
that any personal firewall software you are using is configured to permit 
Connect Me to access the Internet.

Error 719
The PPP session was terminated by the remote machine. This is most likely 
due either to poor signal or to temporary service outages in the network.

Recommendation
 Optimise your signal strength: If indoors, move closer to a window, 

exterior wall or a higher level. Reorienting the computer/wireless 
device may help as well
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 Wait 30 seconds and try to connect again

 If you’re still having difficulty connecting, reboot the computer and try 
again

Error 720: No PPP control protocols configured
This error is typically reported if an unexpected error occurred while 
connecting to a mobile network.

Follow these steps to resolve this error:

 Verify that there is no default dialup connection selected in the 
Control Panel

 If this fails to resolve the error, shut down your computer. Then restart 
the computer and the Connect Me client. Try to connect again

 If this does not work, reinstall the drivers for your 3G mobile device 
(refer to the user's manual for the device for instructions)

 If you are still unable to connect, your device may not be properly 
provisioned for data access. Contact Technical Support for help

Error 721: Remote PPP peer or computer is not responding
This error is typically reported if an unexpected error occurred while 
connecting to a Mobile network.

Follow these steps to resolve this error:

 Verify that there is no default dialup connection selected in the 
Control Panel

 Restart Connect Me and try to connect

 If this fails to resolve the error, shut down your computer. Then restart 
the computer and the Connect Me client. Try to connect again

 If this does not work, reinstall the drivers for your 3G mobile device 
(refer to the user's manual for the device for instructions)

 If you are still unable to connect, your device may not be properly 
provisioned for data access. Contact Technical Support for help

Error 734: The PPP link control protocol terminated
This error is typically reported if an unexpected error occurred while 
connecting to a Mobile network, but it may also be due to poor signal 
strength.

Resolution
 Optimise your signal strength: If indoors, move closer to a window, 

exterior wall or a higher level. Reorienting the computer/wireless 
device may help as well

 Verify that there is no default dialup connection is selected in the 
Control Panel

 Restart Connect Me and try to connect
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 If this fails to resolve the error, shut down your computer. Then restart 
the computer and the Connect Me client. Try to connect again

 If this does not work, reinstall the drivers for your 3G mobile device 
(refer to the user's manual for the device for instructions)

 If you are still unable to connect, your device may not be properly 
provisioned for data access. Contact Technical Support for help

Error 736
This error may be reported if a network connection cannot be established. 
This may be due to poor signal strength.

Resolution
 Click the Cancel button in the main window

 Optimise your signal strength: If indoors, move closer to a window, 
exterior wall or a higher level. Reorienting the computer/wireless 
device may help as well

 Wait for Connect Me to display Ready to Connect

 Try to connect again

Error 744
This error may be reported if an unexpected error occurred while you were 
connected to a mobile network.

Resolution
 Click the Cancel button in the main interface window

 Wait for Connect Me to display Ready to Connect

 Try to connect again, but this time, select a network to connect to that 
has a stronger signal

Error 774
This error is typically reported if an unexpected error has occurred while 
connecting to a mobile network.

Follow these steps to resolve this error:

 Verify that there is no default dialup connection selected in the 
Control Panel

 Restart Connect Me and try to connect

 If this fails to resolve the error, shut down your computer. Then restart 
the computer and the Connect Me client. Try to connect again

 If this does not work, reinstall the drivers for your 3G mobile device 
(refer to the user's manual for the device for instructions)

 If you are still unable to connect, your device may not be properly 
provisioned for data access. Contact Technical Support for help.
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Error 777

Possible causes
 Poor signal

 Network resources are unavailable

 There is a problem with one of the wireless device drivers

Resolution
Follow the steps below to resolve this error:

 Make sure that your wireless device is properly connected to your 
computer

 Optimise your signal strength: If indoors, move closer to a window, 
exterior wall or a higher level. Reorienting the computer/wireless 
device may help as well

 Try to connect again

 If you still receive this error, shut down your computer

 Restart your computer and the Connect Me client. Try to connect again

 If the problem persists, there may be a problem with the software 
driver for your wireless device

 You may need to reset the driver for your device. Refer to the user’s 
manual for your device for instructions to reset the driver

— or—

 You may need to obtain and install the latest/updated driver from the 
manufacturer of your device. Updated drivers are usually available to 
download from the manufacturer’s website

 If you have an alternative way to access the Internet:

 Refer to the user manual for your device to obtain the 
manufacturer’s website address

 Download and install the updated driver

 Reboot your computer

 Start the Connect Me client and try to connect

By Problem Description

Device Disabled
Any of the devices used by the Connect Me software can be disabled by 
Microsoft Windows. You can tell Windows to re-enable the device by 
following the appropriate procedure below.

Windows XP
 Open the Windows System Properties folder. The procedure for doing 

this depends on whether My Computer is on your desktop or in the 
first level of the Start menu
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 If My Computer is on your desktop, right click on the icon and then 
select Properties from the menu

 If it is on the first level of the Start menu, select My Computer from 
the Start menu and then click View System Information in the left 
column of the window

 Select the Hardware tab

 Click Device Manager

 Locate the disabled device in Device Manager. Most devices used by 
Connect Me will be listed under the Network Adapters heading, but a 
few may be listed under Modems

 Right click on the disabled device and then select Enable from the 
menu

Windows Vista and Windows 7
 Open the Windows System Properties folder. The procedure for doing 

this depends on whether Computer is on your desktop or in the first 
level of the Start menu

 If Computer is on your desktop, right click on the icon and then select 
Properties from the menu

 If it is on the first level of the Start menu, select Computer from the 
Start menu and then click System Properties at the top of the 
window

 Click the Device Manager link in the left column

 Locate the disabled device in Device Manager. Most devices used by 
Connect Me will be listed under the Network Adapters heading, but a 
few may be listed under Modems

 Right click on the disabled device and then select Enable from the 
menu

No Wireless Device Detected
Connect Me will display ‘No Wireless Device Detected’ if it cannot actively 
communicate with the wireless device. 

Causes for this may include:

 Devices (such as wireless phones) that must be tethered to your 
computer with a data cable (such as USB), but are not currently 
properly connected. Make sure the cables for devices that require them 
are properly attached to both your computer and the device

 External devices (such as wireless phones) that are not currently 
powered on. Make sure external devices are switched on. Make sure 
the batteries of battery-powered devices are charged. Make sure 
devices that must be plugged into an electrical outlet are plugged in

 PC Card, USB, or Express Card devices that are not properly inserted. 
Make sure such devices are firmly seated in the appropriate slots

 The wrong device is selected in the Hardware tab of the Settings 
window. Ordinarily, automatic selection should be specified in the 
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Selection column. If manual selection is specified, verify that the 
selected device is the device you are trying to use

 No driver or an incorrect driver installed. Ensure that the latest drivers 
for the device are correctly installed according to the instructions of the 
device’s manufacturer

Multiple Connections Not Allowed
This error message appears if both of the following conditions are met:

 The Allow simultaneous connections box on the Hardware Tab of the 
Settings window is not checked

 You attempted to establish a second connection while you were still 
connected using another technology

Note: VPN connections established by certain VPN client software (such as 
Checkpoint VPN) may appear to Connect Me as a second connection. In 
such cases, you may also see this message.

Resolution
To prevent this error message from appearing:

 Select Settings from the Tools menu

 Click Hardware

 Check Allow simultaneous connections

 Click OK

Wi-Fi Issues

Why do I keep losing my connection?
This may be due to interference caused by other devices like cordless 
phones, microwave ovens and other 2.4GHz band devices.

Why am I unable to connect to a signal that I can see in Connect 
Me?
Signal strength from the wireless access point may not be strong enough 
to allow reliable connections. It may not be a publicly available access 
point. 

Why Does Connect Me shut down Windows XP's native Wi-Fi 
management?
Connect Me provides significantly more powerful Wi-Fi management than 
XP’s native Wi-Fi engine. However, if you prefer XP’s native tool, you can 
disable Connect Me’s Wi-Fi management entirely. See Zero Config Wi-Fi
for more information.
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Client Auto-Launch

How do I stop Connect Me from launching every time I restart my 
PC?
Follow these steps:

 Click Options then Settings in the menu bar

 Select the Application tab

 Remove the check from the Automatically run this application on 
machine startup box

 Click OK

Accessing the Windows Device Manager
To access the Device Manager on your computer, follow the steps below 
for your operating system:

Windows XP
 Open the Windows System Properties folder. The procedure for doing 

this depends on whether My Computer is on your desktop or in the first 
level of the Start menu:

 If My Computer is on your desktop, right-click the icon, and then 
select Properties from the context menu

or -

 If it is on the first level of the Start menu, select My Computer from 
the Start menu, and then click View System Information in the left 
column of the window.

 Select Hardware

 Click the Device Manager button

 In the Device Manager window, check to see if any device is marked 
with a yellow question mark. Such a question mark indicates that there 
is a problem with the driver

Windows Vista & Windows 7
 Display the Windows System Properties folder. The procedure for doing 

this depends on whether Computer is on your desktop or in the first 
level of the Start menu:

 If Computer is on your desktop, right-click the icon, and then select 
Properties from the context menu

— or—

 If it is on the first level of the Start menu, select Computer from the 
Start menu, and then click System Properties at the top of the 
window.

 Click the Device Manager link in the left column
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 In the Device Manager window, check to see if any device is marked 
with a yellow question mark. Such a question mark indicates that there 
is a problem with the driver

Correcting Default Connection Settings
Several Windows OS RRAS errors can be caused by a network connection 
in the Control Panel being configured as your default connection. This will 
prohibit you from using any other connection type.

Follow the steps below to ensure that the configurations are correct:

 Exit the Connect Me software

 Select Start > Control Panel > Network Connections (or Network 
and Dial-Up Connections)

 A window will appear that lists all of the network connections your 
computer is currently configured to establish. If any connection listed 
under the ‘Dial-Up’ heading includes a check mark, remove this by 
right-clicking that connection and selecting Cancel as Default 
Connection from the context menu that appears

 Click OK

 Restart the Connect Me software and try to connect

Querying a Wireless Modem
You can query a 3G mobile modem to determine if it's operating properly.

On Windows XP
 Close the Connect Me software

 Display the Windows System Properties folder. The procedure to do this 
varies depending on whether My Computer is on your desktop or in the 
first level of the Start menu

 If My Computer is on your desktop, right-click the icon and then select 
Properties from the context menu

 If it is on the first level of the Start menu, select My Computer from 
the Start menu and then click View System Information in the left 
column

 Select Hardware

 Click Device Manager

 In the Modems group, locate the device that you were using when you 
received the error. Right-click this device and select Properties from the 
context menu

 Select the Diagnostics tab

 Click the Query Modem button. If the device is functioning properly, the 
Diagnostics tab will display a series of commands and responses
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 If you receive an error that states that the modem is not responding 
and another application may be using the port, another application has 
most likely locked the device. See Resolving Application Conflicts

 If you receive any other error or no responses appear at all, your 
device driver is not functioning properly. Refer to the user manual for 
the device for instructions to reinstall or repair the driver

On Windows Vista and Windows 7
 Close the Connect Me software

 Display the Windows System Properties folder. The procedure to do this 
varies depending on whether Computer is on your desktop or in the 
first level of the Start menu

 If it is on your desktop, right-click the Computer icon and then select 
Properties from the context menu

 If it is on the first level of the Start menu, select Computer from the 
Start menu, and then click the System Properties link at the top of 
the window

 Click the Device Manager link in the left column

 In the Modems group, locate the device that you were using when you 
received the error. Right-click this device and select Properties from 
the context menu

 Select the Diagnostics tab

 Click the Query Modem button. If the device is functioning properly, 
the Diagnostics tab displays a series of commands and responses

 If you receive an error that states that the modem is not responding 
and another application may be using the port, another application has 
most likely locked the device. See Resolving Application Conflicts

 If you receive any other error or no responses appear at all, your 
device driver is not functioning properly. Refer to the user manual for 
the device for instructions to reinstall or repair the driver

Resolving Application Conflicts
Shut down all other applications that are running on your computer and 
try to connect again. If you still receive this error, follow the steps below 
to locate the application that is locking your wireless device:

 Simultaneously hold down <Ctrl> and <Alt>, then press the 
<Delete> key

 Click on Task Manager

 Close each application listed in the Applications tab. To do this, select 
the application and then click the End Task button. Repeat as 
necessary until all applications except Task Manager have been 
removed from the list

 Select the Processes tab
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 Click the End Process button to shut down all of the processes except 
the following:

 Windows Explorer/Internet Explorer (designated "explorer.exe" in the 
Image Name column)

 Task Manager (designated taskmgr.exe in the Image Name column)

 Every program for which the User Name is "SYSTEM"

 Close Task Manager by clicking the x at the top right of the window or 
selecting the File menu > Exit Task Manager

 Try your connection again. If this resolved the problem, restart your 
computer and reconnect

 If you receive this error again either now or in the future, repeat the 
steps above, but this time:

 In Step 3, click the End Task button for only one program at a 
time

 After each time you click End Task, try your connection

When the error no longer appears, you will have identified which program 
was creating the conflict and know how to shut it down in the future.

Zero Config Wi-Fi
Zero Config is the Wi-Fi management utility built into Windows XP. 
Connect Me provides significantly enhanced Wi-Fi management 
capabilities, including the following:

 Automatically logging on to all of your wireless provider's partner Wi-Fi 
networks

 Specifying connection priority on a network by network basis, allowing 
dynamic roaming not only to other Wi-Fi networks, but also to 3G 
mobile networks (and vice versa)

 If desired, automatically shutting down your Wi-Fi connection when you 
establish a connection to another network technology, such as the local
network at your home or office

 Configuring a VPN client, your browser, or other applications to be 
automatically launched when you connect to selected Wi-Fi networks

 In order to provide these enhanced capabilities, Connect Me must 
manage Wi-Fi connections itself. Since Wi-Fi cannot be managed by 
two different applications simultaneously, Zero Config is shut down

Note: The native Wi-Fi management tool in Windows Vista and Windows 7 
is a completely different tool than XP’s Zero Config. These operating 
systems do not allow third-party applications such as Connect Me to shut 
the tool down. However, they do provide support for external 
enhancements. This allows Connect Me to provide almost as much 
functionality on Windows Vista and Windows 7 as it does on XP, without 
actually shutting the tool down.
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How do I return Wi-Fi Control to Zero Config?
Connect Me returns control to Zero Config automatically whenever you exit 
the Connect Me application. If you would rather use Zero Config to 
manage Wi-Fi connections even when Connect Me is running, you must 
disable Connect Me's Wi-Fi management.

 Select Options then Settings in the menu bar

 Select the Application tab

 Remove the check from the box labelled Use this as my default Wi-
Fi management utility

 Click OK

Note: This procedure disables ALL of Connect Me’s Wi-Fi functionality and 
hides all Wi-Fi related items in the user interface.

Technical Support
For information on obtaining technical support for the Connect Me 
software, select About from the Help menu. 

When contacting support, be ready to supply information about the version 
of Windows and the type of wireless device you are using as well a 
description of the problem you are experiencing.
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Getting Started

Install the Connect Me Software 


To install Connect Me From a downloaded file

· Download the Connect Me Client from www.telecom.co.nz/connectme

· Navigate to the folder in which the Setup.exe file was saved

· Double click the Setup.exe file  


· Follow the on screen instructions 

To Install Connect Me From a 3G Mobile Device 


Some 3G mobile devices are capable of storing the Connect Me installer in their memory. If you have such a device and Connect Me has been pre-loaded on the device by the manufacturer, the Connect Me installer will be launched the first time you connect the device to your computer. Just follow the instructions on screen to complete the installation. 


Launch Connect Me 


Once your hardware is installed and ready to connect, double click the Connect Me icon on your desktop. 


To Uninstall Connect Me 


Windows Vista and Windows 7 


· Select Control Panel from the Windows Start menu


· Select Uninstall a Program from the Programs group 


· Select Connect Me from the list of applications that appears 


· Click Uninstall


Windows XP 


· Select Control Panel in the Windows Start menu


· Click Add or Remove Programs 


· Select Telecom NZ Connect Me from the list


· Click Remove

System Requirements


		 

		Windows XP

		Windows Vista

		Windows 7



		Processor

		300 MHz, 32 bit

		1 GHz, 32 or 64 bit

		1Ghz, 32 or 64 bit



		RAM

		256 MB

		1 GB 

		1 GB 



		Hard Drive Space

		100 MB

		120 MB

		120 MB



		Internet Explorer

		IE 5.5

		IE 7

		IE 8



		OS Service Pack

		Service Pack 3

		Service Pack 1 
(or above)

		-





Additional Requirements:


· Windows Vista and Windows 7 requires a DirectX 9.0 (or better) graphics accelerator


· Internet Connection (if downloading the installer from the Internet)

· CD-ROM (if installing from CD)


· Compatible Wi-Fi device for wireless LAN connections

· Compatible 3G mobile (GSM) device for wireless WAN connections

Know your Connection Manager

Select Connection Interface


Click these tabs to switch between the two versions of the main window:
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		Wi-Fi version
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		3G version





The Main Window: Wi-Fi Version
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· You can do the following here: 


· Select different networks with Choose an Available Network

· Create and edit network profiles by selecting Options then Profiles

· Configure various user preferences settings by selecting Options and then Settings

· Connect/Disconnect from the network


· See how long you have been connected with the Connection Timer (you can hide this on the Application tab of the Settings window) 


· See if you are connected to a Virtual Private Network (VPN) (this might not appear if your VPN client software is not supported by the Connect Me software)

· See how strong your signal is with the signal strength indicator

Main Window: 3G Version
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This window will display information about the status of your current 3G mobile connection (if any). 

You can do the following here:


· Connect Me should automatically select the TelecomNZ network or one of our roaming partner networks. Connect to establish a connection to the selected network


· Track your total data usage in Data Usage Indicator. The bar is green up to the monthly maximum for your data plan. Usage over your monthly maximum is shown in red. Clicking this indicator opens the Usage Meter.


Note: This indicator does not appear until Usage Meter has been configured.


Note: The Connect Me usage meter is a guide only and does not accurately reflect your billed data. Always check the online usage meters at http://www.telecom.co.nz/homepage  

· Create and edit network profiles by selecting Options and then Profiles 


· Configure various user preference settings by selecting Options and then Settings 


· Connect / Disconnect from the 3G mobile network

· See your connection status for currently selected network


· See how long you have been connected with the Connection Timer. When connected to a 3G mobile network, this indicates how long it has been since the connection was established. You can hide this on the Application tab of the Settings window


· The roaming indicator will appear if the currently-selected 3G mobile network is a roaming network. E.g. you are roaming off the TelecomNZ home network if you connect to this. Consult your contract or http://www.telecomroaming.co.nz/support/data/ for more information 


Controls for the Main Window


The buttons in the upper-right corner of the main window control the appearance and location of the window.
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		Reduce the window to an icon on the task bar at the bottom of the screen.
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		Display the mini bar version of the main window. Click [image: image7.png]



 to return the window to full size.
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		Close the Connect Me application.





The Main Window: Mini Bar Version


This is useful when you want the Connect Me software to take up less space on screen. 
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 The Menu Bar
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		Connections ([image: image11.png]



= new messages) 
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		Options
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		Help
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		Self Service





Connections 

This provides various tools to enhance or provide information on your wireless connections. They include:
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		Messages. Click this to view and/or send messages in the Text Messaging Client. The number of new messages will appear to the right of this icon.
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		Mobile Info. This displays some technical information about the mobile network you are connected to (if any) and your current 3G mobile device.
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		Wi-Fi Info. This displays some technical information about the Wi-Fi network you are connected to and your current Wi-Fi device.
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		User Login. Opens a window that allows you to enter a standard user name and password combination as a default for certain Wi-Fi connections. See Username and Password Logon Window for more information.





To close the Connections Tray, click the Connections icon again.


The Options 

This contains a number of options for configuring the Connect Me software and your wireless device(s):
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		Settings. Allows you to configure a number of personal preference options.
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		Profiles. Used to create and edit network profiles and to set their priority.



		[image: image21.png]





		SIM Lock. Lock and unlock your 3G mobile device. See Locking and Unlocking Your Mobile Device for more information.





Help 

This includes items which may answer questions or help with troubleshooting problems.
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		Help. Opens the help system.
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		History Log. Opens the Advanced Tab of the Usage Meter. This is a troubleshooting tool that provides details on connections, disconnections and detection of new wireless devices.
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		Get Diagnostics. Generate a file containing diagnostics information. If you contact customer support, you may be asked to provide such a file to help troubleshoot any difficulties you may be having.
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		About. Contains version information for the Connect Me software.





Self Service 

This provides a list options to give you one click access to online Self Service areas such as usage meters and prepaid top ups.
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		Prepaid Top Up. To top up prepaid mobile accounts.
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		Your Telecom. To manage your accounts online. You can: 


·  View your bills online


·  Turn off your paper invoices and statements

·  Get details of recent calls you’ve made


·  Check your broadband usage


·  Update your account details and email preferences
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		Usage Meter. To open the online prepaid usage meter 





The System 


When Connect Me is running, it may place an icon like the examples shown below in the Windows system tray.
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		The Wi-Fi interface is selected.
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		The 3G interface is selected.





For either version of the icon, the number of green bars represents the strength of the signal being received from the currently-selected network.


· By clicking on this icon you can open the main window of the Connect Me software, if this is already open, you will move it in front of the other open applications. 

· Note: you can also right click and select show to do this.

· Right click on Help opens the help system

· Right click on Exit you can exit Connect Me


Automatic vs. Manual Connection


By default, Connect Me will automatically select an available network and establish a connection based on the priorities specified in the Network Profiles window. However, you can manually select a network if you wish. See the following topics for instructions:


· Manually Connecting to a 3G Mobile Network

· Manually Connecting to a Wi-Fi Network

If you manually connect to a network, it will disable the automatic connection for that technology type (e.g. 3G Mobile or Wi-Fi). If you wish to return to automatic connection mode, restart the Connect Me software.


 


Establishing Mobile Connections


 XE "Connect button" \* MERGEFORMAT 

 XE "Connecting:to Mobile Networks" \* MERGEFORMAT 

 XE "Connecting" \* MERGEFORMAT 

 XE "GSM:Establishing Connections" \* MERGEFORMAT 

 XE "GSM" \* MERGEFORMAT 

 XE "Mobile:Establishing Connections" \* MERGEFORMAT 

 XE "Mobile" \* MERGEFORMAT 

 XE "Network Profiles:Mobile" \* MERGEFORMAT 

 XE "Network Profiles" \* MERGEFORMAT Manually Connecting to 3G Mobile Networks


Before you begin, you will need:


· A 3G mobile device capable of establishing connections. Windows device drivers for this device must be properly installed according to the manufacturer's instructions

· A valid Pre-paid or Post-Paid account with  TelecomNZ.

· A network profile configured to access  TelecomNZ (Connect Me creates these automatically when you connect a supported 3G mobile device)

Follow these steps to connect to a 3G mobile network:

· If you have not already done so, connect the device that you wish to use


· Select the 3G tab in the main window. If your device is properly connected and configured, the Connection Manager will search for an available network and select an appropriate network profile to use for the connection 


· When Connect Me is ready, it will display the words ‘Ready to connect.’ Click Connect to establish a connection 


Once connected, Connect Me will display a timer indicating the duration of the current connection.


Locking and Unlocking Your Mobile Device


You can lock your 3G mobile device to prevent it from being used by yourself or others. A locked device cannot be used to establish a connection.


Locking the Device


· Select Options and then SIM Lock in the menu bar 

· Enter your current SIM PIN in the space provided

· Click OK to lock the device

Unlocking the Device


· Select Options and then SIM Lock in the menu bar

· Enter your current SIM PIN in the space provided

· Click OK to unlock the device

PUK Codes


Devices sometimes have a limit to the number of incorrect PINs you can enter. This ranges from three to ten possible PIN entry attempts. If you fail to enter a correct PIN within the number of permitted attempts, a window that allows you to enter a PUK Code appears.


Note: Depending on who you ask, PUK stands for either "Personal Unblocking Key" or "PIN Unlock Key." But, both names refer to the same code.


To enter a PUK code and reset your 3G mobile device's PIN:

· If you do not know your device's PUK code, contact technical support to obtain the correct code. The TelecomNZ default PUK code is '1234'

· If it is not already open, open the ‘Enter PUK and Change PIN Code’ window by selecting Options and selecting SIM Lock in the menu bar

· Type your PUK in the Current PUK Code box

· Enter your new PIN in both the New PIN Code and the Confirm New PIN Code boxes

· Click OK

Important: If you enter the PUK code ten times in a row incorrectly, your SIM will be disabled permanently.


 XE "GSM:Mobile Info Dialog" \* MERGEFORMAT 

 XE "GSM" \* MERGEFORMAT 

 XE "Mobile:Mobile Info Dialog" \* MERGEFORMAT 

 XE "Mobile" \* MERGEFORMAT 

 XE "Tools menu" \* MERGEFORMAT To view information about your 3G mobile device or your current 3G mobile connection:


· Select Connections and then Mobile Info  in the menu bar

· The Mobile Info window provides useful information on your computer and your 3G mobile device

The Two Tabs in the Mobile Info window are:


 XE "Firmware Version:of Mobile Device" \* MERGEFORMAT 

 XE "Firmware Version" \* MERGEFORMAT 

 XE "IMSI" \* MERGEFORMAT 

 XE "OS (Operating System)" \* MERGEFORMAT 

 XE "Port (of mobile device)" \* MERGEFORMAT 

 XE "IMEI" \* MERGEFORMAT 

 XE "Device Driver" \* MERGEFORMAT 

 XE "Serial Number (of mobile device)" \* MERGEFORMAT 

 XE "Phone Battery Status" \* MERGEFORMAT 

 XE "SIM" \* MERGEFORMAT 

 XE "GSM:Mobile Info Dialog" \* MERGEFORMAT 

 XE "GSM" \* MERGEFORMAT 

 XE "Mobile:Mobile Info Dialog" \* MERGEFORMAT 

 XE "Mobile" \* MERGEFORMAT 

 XE "Tools menu" \* MERGEFORMAT Diagnostics: Device Tab


This tab contains detailed information about your device which is accessed via the driver installed on your computer. If the driver contains no information or information that is incorrect, it will be reflected in the appropriate field.


The information you will find in the Device Tab is as follows:


· OS (SP): The operating system currently installed on your computer and any service packs (updates) that have been installed for that operating system

· Port: The communications (COM) port that your wireless device is currently attached to

· Modem Manufacturer: The name of the manufacturer of your wireless device

· Modem Model: The model name of your wireless device

· Hardware ID: The hardware ID of your wireless device

· Device Driver: The version of the driver for your wireless device currently installed on your computer

· Firmware Version: The version of your wireless device's onboard operating software


· Serial Number: Your wireless device's serial number


· IMSI#: A mobile subscriber's SIM is assigned a unique 15 digit IMSI (International Mobile Subscriber Identity) code. This allows any mobile network to know the home country and network of the subscriber

· IMEI#: International Mobile Equipment Identifier, a number string uniquely identifying a 3G mobile device

· Phone Number: The telephone number of your 3G mobile device

· Phone Battery Status: The status of your phone's battery

 XE "APN" \* MERGEFORMAT 

 XE "Signal Strength" \* MERGEFORMAT 

 XE "IP Address:for Mobile Connection" \* MERGEFORMAT 

 XE "IP Address" \* MERGEFORMAT 

 XE "GSM:Network Name" \* MERGEFORMAT 

 XE "GSM:Mobile Info Dialog" \* MERGEFORMAT 

 XE "GSM" \* MERGEFORMAT 

 XE "Mobile:Network Name" \* MERGEFORMAT 

 XE "Mobile:Mobile Info Dialog" \* MERGEFORMAT 

 XE "Mobile" \* MERGEFORMAT Diagnostics: Network Tab


The Network tab contains information about the mobile network you are currently connected to (if any).


· Network Type: The type of 3G mobile network you are connected to

· Network Name: The name of the 3G mobile carrier you are connected to

· Signal Strength (%): The strength of the signal being received from this network, as a percentage of a maximum possible signal strength

· Signal Strength (dBm): The strength of the signal being received from this network

· APN Used: The name of the access point to which you are connected

· Country: The country in which the network access point is located

· Status: Indicates whether you are currently connected or disconnected

· Data received during the session: The amount of data received over this connection since it was established (in bytes)

· Data sent during the session: The amount of data sent over this connection since it was established (in bytes)


· IP Address: The IP address you are using for this connection

Establishing Wi-Fi Connections


 XE "Closed Networks" \* MERGEFORMAT 

 XE "Connecting:to WiFi Networks" \* MERGEFORMAT 

 XE "Connecting" \* MERGEFORMAT 

 XE "WiFi:Network List" \* MERGEFORMAT 

 XE "WiFi:Connecting to" \* MERGEFORMAT 

 XE "WiFi:Data Encryption" \* MERGEFORMAT 

 XE "WiFi:Closed Networks" \* MERGEFORMAT 

 XE "WiFi" \* MERGEFORMAT 

 XE "New Networks Options" \* MERGEFORMAT Manually Connecting to a Wi-Fi Network


· Select the Wi-Fi tab in the main window

· If you have not already, connect your Wi-Fi device to your computer. If your device is properly connected and configured, Connect Me will begin searching for an available network. When Connect Me is ready, the button below the signal strength indicator will display the name of the network that has been selected

· Click Connect to access the selected network 

· To connect to a different network, click the button below the signal strength indicator. Then select the network you want to connect to

Note: To connect to a ‘closed’ item in the networks list, you must create a profile for that network. See ‘How to Access a Closed Network’.

Prompts


Connect Me will attempt to establish a connection to the selected network. You may see either one or both of the following prompts during this process:


· If the network is encrypted, you will be prompted to enter an encryption key. If you know the required encryption key, enter it and click OK. If you don't know the key for an encrypted network, you must click Cancel and select a different network. See How to access an encrypted network 


· When connecting to a network for the first time, Connect Me may display the New Network Options prompt. Using this dialog box, you can configure Connect Me to automatically connect to a network in the future or to prompt you when that network is available

The List of Wi-Fi Networks


Clicking the button below the signal strength indicator in the Wi-Fi version of the main window opens the Wi-Fi networks list.
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To connect to a network on the list either select the network and then click the Connect button or double-click on the network in the list. The information displayed for each network will include some (if not all) of the items shown below Right-clicking in the window will produce a menu that controls which columns are displayed

· Connect: This column provides connection/disconnection buttons for each available network


· Preferred: A check mark is presented for any Wi-Fi network that is currently listed in the Network Profiles window. This includes network profiles that have been pre-defined by TelecomNZ, Wi-Fi networks for which you have created Network Profiles and Wi-Fi networks that you have already connected to (for which a profile was automatically created)


· Network: This is the Network Signal Set IDentifier (SSID) - essentially just a name that is broadcast by a Wi-Fi access point to identify the network. If you see a ‘closed’ item in this column, this indicates the presence of one or more Closed networks. See ‘How to Access a Closed Network’

· Mode: two possible entries (shown below) 
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		Indicates this network is in infrastructure mode. You will be connecting to a network through a dedicated wireless access point.
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		Indicates this network is in ad hoc mode. You will connect directly to another computer through its Wi-Fi device.


Note: You can share your Internet connection by hosting an ad hoc Wi-Fi network. See Hosting an Ad Hoc Connection for more information.





· BSSID: The MAC address of the Access Point’s Wireless Network Interface Card

· Channel: The channel on which the wireless network is broadcasting

· AP Vendor: The manufacturer of the wireless access point

· Encryption: Networks that are encrypted will have a dark gray padlock icon. See How to access an encrypted network for instructions on connecting to encrypted networks. Non-encrypted networks will have a lighter gray padlock and no accompanying text

· Signal Strength: A gauge showing the strength of the signal being broadcast from each network. Stronger signals tend to produce more reliable connections

· Beacon Period: Wireless access points periodically broadcast a packet called a ‘beacon’ which helps to synchronize communications with connected systems. This number indicates how often (in milliseconds) the beacon is transmitted

· Supported Rates: A list of all the transmission rates supported by this network

· Time First Seen: The time of day when Connect Me first detected this network. This value represents the current session only. It will reset when you restart Connect Me

· Time Last Seen: The time of day when Connect Me last detected this network

Wi-Fi Network List - Display Options


Right-clicking in the Wi-Fi networks list produces a menu that controls display options for the list. All of the items in the top section of this menu correspond to columns in the list of Wi-Fi networks. Checked and uncheck items to display or hide. 

Additional items in the menu:


· Show Closed Networks: When checked, Connect Me will indicate that one or more closed networks are present by displaying ‘closed’ in the Wi-Fi networks list. Removing the check from this item will suppress the indication 

· Consolidate Networks: When two or more hotspots are broadcasting the same network name they are almost certainly accessing the same network, so Connect Me normally only lists the hotspot with the strongest signal for any network. If you would prefer that all hotspots that broadcast the same network name are listed individually, remove the check

· Reset Columns: Select this to restore all the check marks in the top section of the menu to their default states

· Show All Columns: Select this to check all items in the top section of the menu

· Hide All Columns: Select this to uncheck all items in the top section of the menu

 XE "WiFi:Network Profiles" \* MERGEFORMAT 

 XE "WiFi:Settings Tab" \* MERGEFORMAT 

 XE "New Networks Options" \* MERGEFORMAT 

 XE "Network Profiles:Creating" \* MERGEFORMAT Options for Connecting to a New Network


If Prompt me before saving network settings is selected in the Automatic Profile Creation Settings window, a dialog box will offer four options each time you connect to a new network for the first time. The option selected specifies the type of profile that will be created for this network. By creating a profile automatically, Connect Me makes it easier for you to connect to the same network in the future. You must choose one of the following options:


· Automatically connect to network in future: The profile created will specify that Connect Me should automatically establish a connection to this network whenever it is detected

Note: When multiple networks configured for auto-connection are detected, Connect Me will choose which network to connect to based on the ranking of profiles in the ‘Network Profiles Window’

· Prompt me before connecting to this network: The profile created will specify that Connect Me should offer to connect to this network whenever it is detected

· Save settings for manual connections: The profile created will save the settings used to connect to this network. This allows Connect Me to automate the details of establishing a connection to this network. You must still initiate connections to this network manually by selecting the network and then clicking the Connect button

· Do not save settings: You can connect to the network this time, but no settings will be saved for future connections (no profile will be created)

 XE "Closed Networks" \* MERGEFORMAT 

 XE "WiFi:Closed Networks" \* MERGEFORMAT What is a Closed Network?


Closed networks are private networks that do not choose to broadcast their existence. Connect Me can detect when there are closed networks present simply because it ‘sees’ unidentified broadcasts in the Wi-Fi frequency band. When this happens, it will display ‘closed’ in the Wi-Fi networks list.


Note: Connect Me cannot detect the actual name of or establish a connection to a closed network unless you create a profile for that network. For more information, see How to create a Wi-Fi Network Profile.

 XE "Closed Networks" \* MERGEFORMAT 

 XE "Connecting:to WiFi Networks" \* MERGEFORMAT 

 XE "Connecting" \* MERGEFORMAT 

 XE "WiFi:Connecting to" \* MERGEFORMAT 

 XE "WiFi:Closed Networks" \* MERGEFORMAT 

 XE "Network Profiles:Wi-Fi" \* MERGEFORMAT 

 XE "Network Profiles" \* MERGEFORMAT How To Access a Closed Network


To access a closed network with Connect Me, you must set up a Profile for that network:

· Select Options and then Profiles in the menu bar


· Select Add New Profile from the Settings menu

· Select Wi-Fi

· Click Add

· Enter the name of the network you want to add in the SSID field. The network name is case sensitive and must be entered exactly as provided by the administrator of the closed network you want to connect to

· Check the This is a non-broadcasted network (closed) box to identify this as a closed network


· Complete the remaining fields on this page as instructed by the administrator of the closed network


· Click Next to continue to the General page of the profile wizard. Configure the remaining fields as desired


· Click Finish

Wi-Fi Encryption


Introduction to Wi-Fi Encryption


Unlike a wired local network, a wireless network cannot easily be protected from potential intruders by physical barriers such as walls. Since radio signals travel through physical objects, a potential intruder merely needs to have a look with the right equipment to see the traffic traveling across a wireless network. For this reason, wireless networks often employ encryption to protect their users. To access an encrypted network you will need the encryption key used by that network.

 XE "Encryption Key" \* MERGEFORMAT 

 XE "WiFi:Data Encryption" \* MERGEFORMAT What is an Encryption Key?


An encryption key is a code key used to encrypt data exchanged between an encrypted network and Connect Me. You cannot exchange data with an encrypted network without having the appropriate encryption key.


The key for encrypted networks must be obtained from the administrator of the encrypted Wi-Fi Network you are trying to access.


 XE "Connecting:to WiFi Networks" \* MERGEFORMAT 

 XE "WiFi:Data Encryption" \* MERGEFORMAT How to Change an Encryption Key


When a network is added to the list in the Network Profiles window, all encryption information is saved with it. Therefore, you will not be asked for encryption information again when connecting. For security purposes, the network administrator may change the encryption key for the network. When this happens, you will need to update the key in the appropriate network profile to match the new key specified by the network administrator. Follow these steps:

· Select Options and then Profiles in the menu bar

· Select the network for which you wish to edit the encryption keys

· Click Edit

· Switch to the Wi-Fi tab

· Enter the new encryption key in both the Network Key box and the Confirm Network Key box

· Click OK

 XE "WiFi:Data Encryption" \* MERGEFORMAT 

 XE "WEP (Wired Equivalent Privacy" \* MERGEFORMAT Wired Equivalent Privacy (WEP)


WEP was the standard encryption technology used in the early days of Wi-Fi networks. More secure methods, such as WPA have since emerged, but WEP remains an extremely popular choice for encrypted networks. There are two variants of WEP:


· WEP Open: By far the most commonly used version of WEP. Networks that use this don't bother to verify that you have the correct encryption key before allowing you to connect - if you don't have the connect encryption key, you won't be able to communicate with the network anyway

· WEP Shared: Forces you to prove you have the correct encryption key before allowing you to connect, they do this by sending out sample text for Connect Me to encrypt. If the network gets back what it expects, it will allow you to connect. Ironically, this is less secure than WEP Open because the verification process used gives potential intruders useful information about the contents of the encryption key

 XE "WiFi:Data Encryption" \* MERGEFORMAT 

 XE "WiFi" \* MERGEFORMAT 

 XE "WEP (Wired Equivalent Privacy" \* MERGEFORMAT 

 XE "WPA2" \* MERGEFORMAT 

 XE "WPA-PSK" \* MERGEFORMAT 

 XE "WPA (WiFi Protected Access)" \* MERGEFORMAT Wi-Fi Protected Access (WPA and WPA2)


Wi-Fi Protected Access (WPA) is a key improvement over WEP for both businesses and home users. It was developed when an industry trade group known as the Wi-Fi Alliance became concerned that the security in the existing WEP standard was insufficient. They quickly issued an interim standard that would address most of their concerns while they developed a more complete final standard. The interim standard became known as WPA, while the final standard would be termed WPA2. To use WPA, you need a WPA-compliant Wi-Fi device.


What are TKIP and AES?


TKIP and AES are different encryption protocols that can be used with WPA. TKIP was used in the original WPA specification. AES, which is even more secure, was added as an alternate method to later versions of the specification. So, if the network uses WPA but doesn't specify which of these it uses, TKIP is the most likely to be supported by the network.


What Does "PSK" Stand For?


‘Pre-Shared Key’ - it simply means that the encryption key must be given to you by the administrator of the Wi-Fi network before you attempt to connect so that you are able to enter it when prompted to do so.


 XE "Connecting:to WiFi Networks" \* MERGEFORMAT 

 XE "WiFi:Connecting to" \* MERGEFORMAT 

 XE "WiFi:Data Encryption" \* MERGEFORMAT 

 XE "WiFi:Network Profiles" \* MERGEFORMAT How to Access an Encrypted Network


The steps required to connect to an encrypted Wi-Fi network are the same as those required to connect to a non-encrypted Wi-Fi network — until you click Connect. When you click the Connect button, a dialog box will prompt you to enter a network encryption key. In order to proceed, you must enter the network encryption key obtained from the administrator of the network you are trying to access.


When you are finished, click Connect on the prompt dialog to proceed.


Note: If you create a profile for this network containing the appropriate encryption parameters, you will not see this dialog box when you attempt to connect after your initial connection.


Username and Password Logon Window


Selecting Connections and then User Login in the menu bar causes the Username and Password Logon window to appear. 


If your wireless data provider grants you access to certain pay or subscription Wi-Fi networks, the provider will typically give you a username and password to use when logging into such networks. If you don’t want to enter that username and password each time you connect to such a network, you can specify them in this window.


Note: The username and password entered here will be used only for pay or subscription Wi-Fi networks that your wireless data provider grants you access to. It will not be used for other networks.

· Enter your user name in the Username box

· Enter your password in the Password box

· Enter your password again in the Confirm Password box

· Choose the Save option that best suits your needs:


· Save Nothing


· Save Username only


· Save Username and Password


· Click OK to save your entries and close the window, or click Cancel to discard your entries and close the window

Ad Hoc Connections


What is an Ad Hoc Network?


Ordinarily, Wi-Fi access to networks is provided by specialised devices called ‘Access Points.’ Access points communicate wirelessly with your computer's Wi-Fi device, granting you access to the network they are attached to.


However, end user Wi-Fi devices can also establish connections directly to one another rather than to a network access point. Such connections are called ‘ad hoc networks.’ Here, one computer becomes an ad hoc host, performing some of the actions that would normally be performed by the access point. Then, another end user device is able to establish a connection to the host computer.


Limitations & Security Issues


There are key limitations and security issues with Wi-Fi ad-hoc mode wireless networking:

· Wi-Fi devices in ad hoc mode (hosting or participating) offer minimal security against unwanted incoming connections. I.E. ad hoc Wi-Fi devices cannot disable SSID broadcasts the way infrastructure mode devices can. Attackers will have little difficulty connecting to your ad hoc device if they get within signal range

· Signal strength indications that are accessible when connected in infrastructure mode are unavailable to you when you are in ad hoc mode. So, you will face some difficulty when you reposition an ad hoc device to achieve a better signal

· The Wi-Fi networking standards (including 802.11g) require only that ad hoc mode communication supports 11 Mbps bandwidth. You should expect that Wi-Fi devices that support 54 Mbps or higher in infrastructure mode will drop back to a maximum of 11 Mbps when changed to ad hoc mode. Thus ad hoc mode should generally be viewed as ‘slower’ than infrastructure mode

Hosting an Ad Hoc Connection


Hosting an ad hoc network allows you to share your computer’s Internet or other network connection with another computer over Wi-Fi. Establishing such a connection has three steps:

1. Creating an Ad Hoc Wi-Fi Network Profile


· Select Options and then Profiles in the menu bar

· Select Add New Profile from the Settings menu

· Select Wi-Fi

· Click Add

· In the SSID Field, enter the network name (SSID) you want your computer to broadcast


· Check This is a hosted ad-hoc network (Computer to Computer)

· Click the Advanced button

· Check Enable Internet Connection Sharing when this network connects

· Pull down the Select host connection to share menu and select the network connection you would like to share over Wi-Fi. If you are currently connected to a network, ‘Currently active Internet connection’ is listed at the top of this menu

· The remaining options correspond to the potential connections listed in the Network Connections window of Microsoft Windows operating systems. These will be displayed in roughly the following order:

· Wi-Fi and LAN connections


· 3G and dialup connections


· VPN connections


· Click OK

· Click Next

· Configure the settings on the General page as desired

· Click Finish

2. Using an Ad Hoc Profile


Once you have created a network profile to use for hosting an ad hoc connection, the profile will appear in both the list of Wi-Fi networks and the Network Profiles window. Select this profile in either of these lists and then click the corresponding Connect button to broadcast the availability of the ad hoc network. Connect Me will indicate that it is connecting


3. Establish a Connection to an Ad Hoc Host


Once a host computer is broadcasting its availability for ad hoc Wi-Fi connections, you should be able to establish a connection to it using another computer that supports ad hoc Wi-Fi connections. Follow these instructions to establish a connection to such a host:


· Start the Connect Me software

· Select the Wi-Fi tab


· Click the button below the signal strength indicator

· Click the Connect button associated with the ad hoc host you wish to connect to 

Note: Ad hoc hosts display a different icon to Wi-Fi and 3G mobile connections in the Mode column.

· When the connection has been established, Connect Me will indicate ‘Connected’

The Wi-Fi Info Window


Select Connections and then Wi-Fi Info in the menu bar to open a window with two tabs.


 XE "Firmware Version:of WiFi Device" \* MERGEFORMAT 

 XE "Firmware Version" \* MERGEFORMAT 

 XE "MAC Address (of Wi-Fi Device)" \* MERGEFORMAT 

 XE "Device Driver" \* MERGEFORMAT 

 XE "WiFi:Wi-Fi Info Dialog" \* MERGEFORMAT Wi-Fi Info: Device Tab


This tab contains information about the Wi-Fi device you are currently using.  


· Vendor description: Information about the manufacturer of your  
Wi-Fi device

· MAC address: The hardware address of the device. MAC (Media Access Control) addresses are unique number sequences assigned by the device's manufacturer and usually cannot be altered. These addresses are used for transferring data by hardware-level protocols such as Ethernet and 802.11. Higher level protocols such as the TCP/IP protocol suite used by the Internet have their own addressing schemes, but still rely on the hardware-level protocol for the transfer of data between individual nodes on a network

· Driver version: The version of the driver for the device currently installed on your computer

· Firmware version: The version of the device's on-board operating software

 XE "WiFi:Wi-Fi Info Dialog" \* MERGEFORMAT Wi-Fi Info: Network Tab


This tab displays your computer's current Wi-Fi network configuration and the amount of activity on your Wi-Fi connection.


· IP address: The Internet Protocol address your computer is using for the current network Wi-Fi connection. Ordinarily, the address displayed here is assigned only for the duration of the connection. It is most likely not permanently assigned to your computer

· Gateway: The address of the device that is responsible for routing all of your network traffic onto the Internet

· DNS server: The address of the server your computer is using to translate Internet addresses from text to numeric format and back. For example, your browser might use the DNS server to convert google.com to 66.102.7.147

· DHCP server: The address of the server that assigned your computer's network configuration for the current wireless connection

· WINS server: The address of the server (if any) that your computer is using to find the names of computers on a Windows network

· Activity: Displays the number of packets of data that your computer has sent and received over the Wi-Fi connection since it was established

Text Messaging (SMS)


Short Message Service


Connect Me makes SMS simple by allowing the user to send and receive messages from a familiar messaging client.

The Text Messaging Client


You can send and receive texts through Connect Me like you can on your phone. In fact, Connect Me integrates with the existing Text Messaging application on your phone (if using a phone as your modem).


To view text messages, select Connections, then Messages in the menu bar.


You will then be presented with a message viewing and composing application that should feel familiar to anyone accustomed to using popular e-mail software packages.
 


Viewing and Managing Messages


Receiving Text Messages


When you receive an e-mail or a text message, an envelope-shaped indicator will appear next to the Connections icon in the menu bar. The number next to the envelope indicates the number of new messages.


Once the text messaging window opens, a list of your messages will be displayed in the right-hand pane. Each message will be accompanied by one of the following icons:
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		An unread SMS message.
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		An SMS message that you have already read.
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		An unread e-mail message.
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		An e-mail message that you have already read.





Double-click on any message listed to view the complete message.


Updating Your Inbox


If your 3G mobile device is connected to your computer, Connect Me will automatically retrieve new messages from the device when launched. You can also update the contents of your Inbox with either of the following icons:
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		Send/Receive. Connect Me will transmit any unsent messages in your Outbox and query your wireless device for any new messages received. If new messages are present, they will be added to your Inbox.
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		Refresh. Connect Me will delete all messages in your Inbox and then copy all messages on your wireless device into the Inbox. Note that messages that are in your Inbox, but not also on your wireless device will be lost.





Using Text Messaging With Tethered Mobile Handsets


Connect Me can connect to phone handsets over a serial, USB, Bluetooth or IrDA connection. Connect Me will assume that these wireless devices are your primary viewing device for text messages. Therefore, it will not delete any message from the device just because you happen to read it in Connect Me's text messaging interface. However, when you delete a message in the text messaging interface, it will also be deleted from the handset.


If you use your handset to send and receive text messages when it is not attached to Connect Me, Connect Me's text messaging inbox may change when you reattach the handset.


Certain handsets are not able to send text messages during an active data connection. If a device does not support sending a text message while using an active data connection, the message will be queued for delivery as soon as the active data connection is released. This is typically when the user selects the Disconnect button. 
 


Note: Although Connect Me can communicate with a handset over a Bluetooth connection, it cannot perform Bluetooth pairing automatically (you will have to manually pair the computer and the handset).


Managing Text Messages


The text messaging client window provides a number of management functions that allow you to save and organize your incoming and outgoing messages including: 
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		Click this button or select Folders > New Folder from the File menu to create a new folder in which to store messages.
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		Click this button or select Folders > Delete Folder from the File menu to delete a folder you have created (and all the messages it contains).
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		Click this button or select Move to Folder from the Edit menu to move the selected message to another folder. Note that moving a message from the Inbox to another folder will not delete the message from your wireless device. Therefore, the message may re-appear in your Inbox if you re-import messages from the device.
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		Click this button or select Copy to Folder from the Edit menu to place a copy of the selected message in another folder.
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		Click this button or select Delete Message from the Action menu to delete the selected message. Note that deleting a message from the Inbox will also delete it from your wireless device. (If your wireless device is not currently connected to your computer, the message will not be deleted from the device until the device is reconnected.)
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		Click this button or select Load from the File menu to return all folders (except the Inbox) to their state at the time of the last save operation. This is useful, for example, if you accidentally delete messages that you wanted to keep.
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		Click this button or select Save from the File menu to save the current state of all folders (except the Inbox). A Save operation is automatically performed whenever you close the text messaging client window.





Exporting Messages to a File


The content of your messages can be exported to a number of text and graphic file formats. Follow these steps:

· In the text messaging client window, select the message or messages you want to export. You can select multiple messages by holding down the Control key and clicking on each desired message or select a range of messages by clicking on one end of the range and holding down the Shift key while clicking on the other end

· Select Import and Export from the File menu

· Select Export to File

· Click Next

· Select the file format to which you wish to export the selected messages

· Click Finish

Sending Text Messages


Before attempting to send or receive text messages, make sure your 3G mobile device is properly attached to your computer and registered with the 3G mobile network (Connect Me will indicate Ready or Connected).


Note: Connect Me can send text messages when the application is in Ready to Connect mode or when you are actively connected. Some networks, however, may not support sending and receiving text messages while you are actively connected. 


To send a text message, do the following:


· Click New in the text messaging window

· Add the mobile number of the person you wish to send a message to in the To field

· Type the message you wish to send

· Click Send

Using the Address Book


Connect Me includes an Address Book feature which can be used to manage phone numbers and addresses. You can open the address book either by clicking the To… button in the New Message window or by clicking on the icon below in the main text messaging interface:
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The address book appears as shown below.
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From here, you can do the following:


Add a new address book entry by clicking the Add button

Select an entry you want to edit and then click the Edit button

Select an entry you want to delete and then click the Delete button

If you opened the address book from the New Message window, selecting an address book entry and then clicking OK will copy the entries phone number to the To field in the new message window

Note: You can import address book entries stored on your mobile phone.

Accessing Your Device's Phone Book


You can import your 3G mobile device's phonebook entries into Connect Me and export the Connect Me address book to your wireless device. 


Importing Phonebook Entries


To import phonebook entries from your wireless device, click this icon:
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The address book entries from the handset will be added to Connect Me's address book. If an address is already in Connect Me's address book the imported entry will replace the existing entry. 


Exporting Address Book Entries


To export entries from Connect Me to your 3G mobile device, click this icon:
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Important! This will replace the entire phonebook on your 3G mobile device. Anything in the device's phonebook prior to this action will be deleted.


Importing and Exporting Your Address Book


Connect Me can exchange address book information with a variety of sources including the phonebook on your wireless device and Personal Information Managers (PIMs) such as Microsoft Outlook and Lotus Notes. 

Exchanging address book information with a PIM requires running the Import and Export Wizard:

· From the text messaging client window, select Import and Export from the File menu

· Select Import from PIMs or Export to PIMs as desired


Note: the third option, ‘Export to File’, exports messages rather than the address book. See Exporting Messages to a File for more information.


· Click Next

· Select the software package you want to exchange address book information with

· Click Finish

On Board Usage Meter


Displays Connect Me's approximate usage of your 3G mobile data plan. If desired, it can also monitor your total Wi-Fi usage. This should help you monitor roughly how much of your monthly data allotment has been used at any point in a billing period. 

To access this window: Select Connections and then Mobile Usage in the menu bar

Note:  This meter should be used as a guide only and does not accurately reflect your billed data, always check the online usage by using the Self Service buttons that direct you to the meters on http://www.telecom.co.nz 


Important! Usage Meter tracks only the portion of your data plan that is consumed by connections established with Connect Me. The totals displayed here will not include data usage that occurs when you connect via other applications.


To get started, you need to configure the Usage Meter in order to tell it about your plan maximum(s) and your monthly billing date.


Configuring the on board Usage Meter


In order for Usage Meter to report your usage, you must first tell it a little bit about your wireless plan(s):

· Open Usage Meter. Select Connections and then Mobile Usage in the menu bar


· Select your Billing period start date. This is the day of the month on which each billing period begins. You can find this on the monthly bill, online in Your Telecom or in the online Pre-paid usage meter http://www.telecom.co.nz/mbbmeter

· Using the Select Your Plan Limit menu, specify the monthly maximum data usage allowed by your 3G mobile data plan

· If your wireless data plan includes limits for Wi-Fi usage, select the 
Wi-Fi tab and repeat steps 2 and 3, this time include information about your Wi-Fi plan limits

Usage Meter: 3G & Wi-Fi Tab


These tabs of the Usage Meter show your 3G mobile and Wi-Fi data usage respectively. 


Current Usage


The Current Usage section displays a graph of your overall 3G mobile data usage in the current billing period. The red line across the graph indicates the current monthly maximum specified in the Select Your Plan Limit menu on the right. Usage below this limit is displayed in green. Usage beyond this limit is displayed in red.


Other items in this section include the following:


· Show usage for billing period: Once you have selected the start date for each monthly billing cycle (below), you can use this field to examine data usage for past billing periods. Select the billing period you want to view here. The relevant information will be displayed in the graph to the left

· Billing period start date: The day of the month on which each billing period begins. You can usually find this on the monthly statement, online in Your Telecom or in the online Pre-paid usage meter http://www.telecom.co.nz/mbbmeter

· Select Your Plan Limit: Specify the monthly maximum 3G mobile or Wi-Fi data usage allowed by your data plan

· Details: Display the Advanced tab of the Usage Meter with detailed, technical information about various Connect Me events (connections, disconnections, etc)

Cumulative Usage


The Cumulative Usage section displays a graph of your usage, separated into individual sessions. One bar will be displayed for each session. Items on this page include the following:


· Total Sessions: The number of sessions displayed in the graph

· Total Time Connected: The total combined connection time for all sessions displayed

· Reset Counter: Clears the display and resets the number of sessions to zero. This does not alter your overall usage, it just clears this cumulative usage graph so that you may more clearly examine the data for new sessions

· Details: Display the Advanced tab of the Usage Meter with detailed technical information about various Connect Me events (connections, disconnections, etc)

Last 12 Months


This displays a large graph of your usage over the last twelve months. There are no other items on the page.


Usage Meter: Advanced Tab


The Advanced tab of the Usage Meter is a troubleshooting tool that lists every Connect Me event (connections, disconnections, detections of new wireless devices, etc.)


Double-click on any item in the list to see more information about that event


Use the options in the Filter by box to limit the events displayed to a particular date range, connection technology or event type

Check your total combined usage for all events currently displayed by viewing the statistics at the bottom of the window

Delete the record of the events displayed in this window by clicking the Clear Event Log button

Virtual Private Networks (VPNs)


 XE "VPN (Virtual Private Networks)" \* MERGEFORMAT Virtual Private Networks (VPNs) are private networks that can be accessed over a public backbone network (like the Internet) without compromising their privacy. Typically, they maintain their privacy by forming secure (encrypted) ‘tunnels’ directly to the users who access them. For example, a company might set up a VPN for its employees to access the corporate network securely when they are away from the office.


The software responsible for forming the tunnel with the private network is called a VPN client. Because the VPN client and the private network exchange data in an encrypted format, no one on the public network over which this information passes can access it.


 XE "Microsoft VPN Client" \* MERGEFORMAT 

 XE "Supported VPN Clients" \* MERGEFORMAT 

 XE "VPN (Virtual Private Networks):Supported Clients" \* MERGEFORMAT 

 XE "VPN (Virtual Private Networks):Microsoft Client" \* MERGEFORMAT 

 XE "VPN (Virtual Private Networks):Cisco Client" \* MERGEFORMAT Supported VPN Clients


Connect Me currently supports the following VPN clients:


Microsoft VPN Client


Cisco VPN Client


Other VPN clients can be launched by Connect Me, but non-supported client software must be configured manually and its usage has some limitations. See Using a Non-Supported Client for more information.


 XE "Microsoft VPN Client" \* MERGEFORMAT 

 XE "VPN (Virtual Private Networks):Microsoft Client" \* MERGEFORMAT 

 XE "VPN (Virtual Private Networks):Configuring" \* MERGEFORMAT 

 XE "VPN (Virtual Private Networks):Settings Tab" \* MERGEFORMAT 

 XE "VPN (Virtual Private Networks)" \* MERGEFORMAT Configuring a VPN Connection


The instructions below should be used for VPN client software that is supported by Connect Me. 


· Consult the administrator of the VPN you wish to access. They will provide you with VPN client software and instructions for establishing VPN connections using that software

· If the VPN client software is not already installed on your system, install it now. (Microsoft's VPN client is pre-installed on most versions of Windows)

· Open the Connect Me application

· Open the Settings window (Select Options and then Settings in the menu bar)


· Select the VPN tab

· Select Use existing VPN profile. Then, specify the client software and the login profile that you want to use

· Click OK

  


Once VPN settings have been configured, you can configure specific network profiles to automatically start a VPN session upon connection.


Using a Non-Supported VPN Client


Connect Me can launch a VPN client that it doesn't support. However, its ability to work with these clients is very limited. Make sure you thoroughly read these procedures and the usage notes that follow before you attempt to use a non-supported VPN client with Connect Me.


Installing and Configuring the VPN Client Software


The first task in utilising unsupported VPN client software is to make sure that the VPN client is fully installed and configured to establish a connection to your VPN. All configuration of the VPN client software must be done from within the VPN client software itself. Connect Me cannot configure unsupported VPN clients. Work with the administrator of your VPN to achieve the following:


· If the VPN client software is not already installed on your system, install it now

· Configure all the necessary profiles and/or other settings necessary for logging into your VPN

· Determine the exact command line necessary to launch your VPN software and establish a connection to your VPN from the Windows command prompt. This must include any additional command line parameters that are necessary to successfully establish a connection

Important! If you cannot establish a VPN connection from the Windows command prompt, Connect Me will not be able to establish a connection using your VPN client software. Connect Me simply invokes the command line given to it. It has no other interaction with unsupported VPN clients.


Configuring Connect Me


When you can launch your VPN client and establish a VPN connection from the Windows command line, you are ready to configure Connect Me. Follow these steps:


· Open the Connect Me application

· Open the Settings window (Select Options then Settings in the menu bar)

· Select the VPN tab

· Select Use third party VPN client

· Click Browse

· Select the program file to be launched

· Click Open. The path of the selected file should now appear in the Command line field

· If the VPN client software requires that additional parameters be included after the program file name on the command line, enter these in the Parameters field

·  Click OK

Once VPN settings have been configured, you can configure specific network profiles to automatically start a VPN session upon connection.


Usage Notes


Depending on which VPN client you are using, the VPN client may establish a connection automatically or require additional input (password or other credentials) from the user when launched

Connect Me has no way of determining the status of VPN connections established by unsupported VPN clients. Therefore, the VPN indicator in the main window will not update correctly when used with an unsupported VPN client

Be sure to shut down the VPN client software properly (according to the manufacturer's instructions) when you are finished with a VPN session. If the VPN client is not shut down properly, Connect Me may have trouble launching the software the next time it attempts to do so

You cannot shut down the VPN client or its VPN connection from within Connect Me. You must work directly with the VPN client software

 XE "Network Profiles Window" \* MERGEFORMAT 

 XE "VPN (Virtual Private Networks):Auto Launch" \* MERGEFORMAT 

 XE "VPN (Virtual Private Networks)" \* MERGEFORMAT 

 XE "Network Profiles:General Properties" \* MERGEFORMAT Automatically Launching a VPN Connection


You can configure any network profile to automatically connect to a Virtual Private Network whenever you connect using that profile:

· If you have not already done so, configure the connection settings for the VPN you wish to connect to


· Open the Network Profiles window. (Select Options then Profiles)
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· In the left pane, select the profile for which you want to automate VPN connection

· Click Edit

· If the General tab is not already selected, select it now

· Check the Auto Launch box in the VPN section

· Click OK

· Repeat steps 3 through 7 for any additional profiles that you want to auto-launch your VPN connection with

Note: If you want your VPN to be launched automatically with all (or most) of the new profiles you create, consider checking the Autolaunch box on the VPN tab of the Settings Window. This configures the default behaviour of all newly created profiles.


Creating and Managing Network Profiles


 XE "Closed Networks" \* MERGEFORMAT 

 XE "WiFi:Closed Networks" \* MERGEFORMAT 

 XE "Network Profiles" \* MERGEFORMAT A network profile is a saved configuration for connecting to a particular network. Some profiles may have been pre-defined by TelecomNZ Additional network profiles for other types of connections can be created in the Network Profiles window.


Creating Network Profiles has the following advantages:


· You can configure the client to automatically connect to a Network Profile whenever that network is available

· If the last network you connected to is not available at a particular location, the Connect Me will select a network from the list of network profiles in the main window (if one is available). This allows the same easy, one click connection to an alternate network

· You can automate steps in the connection process like entering an encryption key or logging into a VPN so that you don't have to perform these actions each time you connect

· Moreover, you must have a profile for the following:

· You cannot connect to a closed Wi-Fi network unless you create a ‘closed network’ Network Profile

· You must have a network profile for each 3G mobile network that you wish to connect to. Often the Connection Manager will automatically create a profile when you connect a supported 3G mobile device

Creating and Importing Wi-Fi Profiles


 XE "SSID" \* MERGEFORMAT 

 XE "Closed Networks" \* MERGEFORMAT 

 XE "Enable Data Encryption" \* MERGEFORMAT 

 XE "Network Profiles Window" \* MERGEFORMAT 

 XE "Profiles button" \* MERGEFORMAT 

 XE "WiFi:Network Profiles" \* MERGEFORMAT 

 XE "WiFi:Closed Networks" \* MERGEFORMAT 

 XE "WiFi" \* MERGEFORMAT 

 XE "Network Profiles:Wi-Fi" \* MERGEFORMAT 

 XE "Network Profiles:Creating" \* MERGEFORMAT 

 XE "Network Profiles" \* MERGEFORMAT 

 XE "WEP (Wired Equivalent Privacy" \* MERGEFORMAT 

 XE "WPA (WiFi Protected Access)" \* MERGEFORMAT Creating a Profile for a Wi-Fi Network


Follow these steps to create a Wi-Fi Network Profile.

· Select Options and then Profiles in the menu bar

·  Select Add New Profile from the Settings menu 

· Select Wi-Fi

· Click Add 

· In the SSID field, enter the broadcast name of the network profile. Note that the name entered here must exactly match the SSID (Service Set IDentifier) used by the network

· If you are configuring a profile for  a closed network, check This is a non-broadcast network

· If the network whose profile you are configuring does not use WEP or WPA encryption, the Enable data encryption box should remain unchecked and no further security configuration is necessary

· If the network does use WEP or WPA encryption, check the Enable data encryption box and configure the Wi-Fi data encryption settings (see Enabling Wi-Fi Data Encryption)

· Click Next

· Configure the settings on the General page and then click Finish
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· Check the Enable data encryption box

·  Select the Authentication method used by this network. Supported authentication methods include:


· None: Select if the network is unencrypted


· WEP-Open (Normal Method): This is the standard WEP encryption method 


· WEP-Shared: Use this only if told by your network administrator


· WPA-PSK: You will need to enter your pre-shared key in the ‘Network key’ fields provided

· WPA2-PSK: You will need to enter your pre-shared key in the ‘Network key’ fields provided

Note: The WPA methods will only be listed here if your current Wi-Fi adapter supports WPA security.

· Enter the encryption key for this network in Network key and Confirm network key fields 


Automatic Profile Creation Settings


If you wish, Connect Me can automatically create network profiles for each new Wi-Fi network you successfully connect to. The setting that controls this can be found by selecting Wi-Fi Network Options from the Settings menu in the Network Profiles window. The following options are available:


Automatically save all Networks that I connect to


Connect Me will create a new profile for every new Wi-Fi network you successfully connect to.


Prompt me before saving Network Settings


Connect Me will ask you if you want to create a new profile each time you successfully connect to a new network.


Allow manual input of network settings only


Connect Me will not automatically create a network profile.


Importing Wi-Fi Profiles From the Operating System


If you have established connections using the Wi-Fi Management tools built into the Windows operating system, Windows has probably created profiles for the Wi-Fi networks you have connected to. You can import those profiles into Connect Me by doing the following:


· Select Options then Profiles in the menu bar


· Select Import Windows Wi-Fi Profiles from the Settings menu
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Follow these steps to edit an existing network Profile: 


· Select Options then Profiles in the menu bar
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· In the left pane, select the network you wish to edit

· Click the Edit button 

Note: If the profile you are editing was created for you by TelecomNZ, you may not be allowed to edit some of its settings. If this is the case, certain tabs and/or settings may not be present.

· Make the desired changes

· Click OK
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Follow these steps to remove a network from the Network Profiles window:


· Select Options then Profiles in the menu bar


· Select the network that you want to remove from the list in the left pane of the window

· Click Remove

· Click Close

The Network Profiles Window


 XE "Network Profiles Window" \* MERGEFORMAT This window can be used to add Network Profiles and to edit existing Network Profile settings. It can be reached by selecting Options then Profiles in the menu bar.


Click on a portion of the screen shot below for more information on a particular item.
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Profile Priorities


In the Network Profiles Window, profiles are listed in order of priority. When selecting a network to connect to, Connect Me will go down the list from top to bottom, selecting the first network profile for which all of the following are true:

· The network described by the profile is available


· You have a device that is ready and capable of connecting to the network connected to your computer

· The Connection Options field on the General tab in the profile's configuration is set to either ‘Automatic’ or ‘Prompt’

· The profile is not ‘Other Connections’

· Profile priority also determines when Connect Me will automatically switch from one network to another. If you are connected to one network and a higher priority network becomes available, Connect Me will switch to the higher priority network

Changing Profile Priority 


To change the priority of a specific profile, select the profile whose priority you would like to change. Then, click the Up or Down button to move the profile up or down the list.


Other Connections

Unlike the rest of the items in the network profiles list, ‘Other Connections’ is not a network profile. It is simply a placeholder for all network connections of types that are not managed by the Connect Me software. The placement of this item in the list determines how high priority these ‘other’ connections should be considered. If ‘Other Connections’ appears higher in the list than your current connection and you connect a network of ‘other’ type to your computer, Connect Me will automatically shut down its current (lower priority) connection. 


For example, if you had a local network connection of a type that is not managed by Connect Me and you wanted Connect Me to shut down any wireless connections it manages whenever you connected to your local network, you would simply move ‘Other Connections’ above all your wireless network profiles in the list. If, on the other hand, you did not want Connect Me to disconnect in this situation, you could leave it at the bottom of the list.


Note: you can specify which types of networks are included in the ‘Other Connections’ group in the Hardware tab of the Settings window.


Profile Icons


Each profile listed in the Network Profiles window will have an icon next to the name. This icon indicates the technology that this profile uses to establish connections.
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Profile List


This is the list of all the Network Profiles you have defined so far. Also listed here are any Network Profiles that have been pre-configured by TelecomNZ and any profiles that were automatically added when you first connected to a new network. 


A profile's position in the list indicates its priority. 


Profile Rank Buttons


Use these buttons to adjust the ranking of the network selected in the list above. Higher ranked networks (those that appear higher in the list) will be preferred above other networks in the list.


Connect Button


Connect to the currently selected Network Profile.


Profile Add Button


Add a new Network Profile to the list.


Profile Remove Button


To remove a profile from the list, select it in the list above and then click this button.


Note: You cannot remove profiles that have been pre-configured by TelecomNZ

Profile Edit Button


To modify a Network Profile entry, select the Network Profile in the list above and then click this button. 


Network Profile Information


This box displays a quick summary of the information in the selected profile. 

Network Profile Information: Field Definitions


The fields displayed in the network profiles window may include the following:


Profile Name


This is the name of the Network Profile. If you have not named a Wi-Fi profile, this will be the SSID of the network.


Profile Type


This will show if the Profile was created by TelecomNZ (indicated by the word ‘Carrier’) or by you (indicated by ‘User’).


VPN


This indicates if a VPN connection is set to auto-launch when you establish a connection to this network.


Browser


This shows if you have your browser set to auto-launch a page and if you have proxy settings for this profile.


IP Address (3G Profiles Only)


This field indicates whether an IP address will be obtained automatically (using DHCP) or a fixed IP address has been specified.


DNS Server (3G Profiles Only)


This field indicates whether a DNS server address will be obtained automatically (using DHCP) or a fixed DNS server address has been specified.


Broadcast SSID (Wi-Fi Profiles Only)


This indicates whether this Wi-Fi network broadcasts its SSID. Networks that do not broadcast their SSID are called Closed Networks.

Authentication (Wi-Fi Profiles Only)


This indicates the type of WEP or WPA authentication being used by a Wi-Fi network.
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This tab contains the 3G mobile - specific settings for Network Profiles. 


Service


The name of the network for which you are creating the profile. If this is a custom profile, you can specify the network name, otherwise the network name will have been entered for you (and will not be editable).


Service Type


Select the type of service provided by this network. The options include ‘Packet’ for packet data (EDGE/GPRS type) connections and ‘Circuit’ for circuit-switched data (GSM/CSD type) connections. Note, if you have selected a network that only provides one type of service, this menu will only include the type that is provided by the selected network. 


Options include: 


Dialled Number


Is the telephone number that your wireless device must dial in order to connect to the network. In most cases, the dialled number for the selected network will have been pre-entered for you (and will not be editable). If no dialled number has been entered, you must enter the appropriate number here. If you do not know the appropriate information for this network, contact TelecomNZ.


Access Point Name


The name of the wireless access point with which your 3G mobile device communicates when connected to this network. In most cases, the access point name for the selected network will have been pre-entered for you (and will not be editable). If no access point name has been entered, you must enter the appropriate number here. If you do not know the appropriate information for this network, contact TelecomNZ.


User Info


Your username and password for the network.
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This window contains the security settings for Wi-Fi Network Profiles. Follow these steps to configure Wi-Fi network security. 

· In the SSID field, enter the broadcast name of the network profile. Note that the name entered here must match the SSID (Service Set IDentifier) used by the network exactly

· If the network you are configuring is a closed network, check This is a non-broadcast network

· Ordinarily, This is a hosted ad hoc network (Computer to Computer) should remain unchecked

· If you want to use this profile to host an ad hoc network connection, you would check this box and then click Advanced to configure additional properties related to hosting ad hoc Wi-Fi connections

· If the network whose profile you are configuring does not use WEP or WPA encryption, the Enable data encryption box should remain unchecked and no further security configuration is necessary

· If the network does use WEP or WPA encryption, check the Enable data encryption box and configure the Wi-Fi data encryption settings
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The IP Settings page allows you to configure the Internet Protocol (IP) address to be used with this Profile. You will not need to alter these values unless specifically instructed by your administrator.


Profile IP Address


The top group of settings specify the IP address that your system will use when connected to this network. The default selection, Obtain IP address automatically, instructs Connect Me to ask the network to assign it an appropriate address each time it connects. This is the correct setting for most network profiles.


If the network does not support automatic address assignment, you can enter appropriate values manually by clicking Use the following IP address. Contact the administrator of the network whose profile you are configuring to obtain appropriate values for these fields.


Profile DNS server


This lower group of settings specifies the address of the name server that your system should use to translate names (e.g. "smithmicro.com") to numerical addresses when connected to this network. The default selection, Obtain DNS server address automatically, instructs Connect Me to ask the network to provide the address of a name server each time it connects. This is the correct setting for most network profiles.


If the network does not support automatic DNS server assignment, you can enter appropriate values manually by clicking Use the following DNS server address. Contact the administrator of the network whose profile you are configuring to obtain appropriate values for these fields.


Alternately, click the Advanced button to configure detailed settings for DNS and WINS servers.


 


Advanced IP Settings


The Advanced IP Settings window appears when you click the Advanced button on the IP Settings page of the network profile wizard. This window allows you to configure advanced settings pertaining to naming services and protocols to be used with a particular network profile. There are three tabs in this interface:


Advanced IP Settings: DNS Tab


This window allows you to configure the advanced settings pertaining to DNS server use.


DNS server addresses, in order of use


This is a list of DNS servers that may be used. The first listed will be tried first. The second server listed will be used if the first is not available, and so on. To add a server to the list, click the Add button and then enter the IP address of the desired server. If you wish to change the order in which servers are listed, use the arrows on the right.


Append primary and connection-specific DNS suffixes


Selecting this option specifies that when attempting to resolve an unqualified DNS name, your computer will send two different name resolution queries:


The first query it sends is based on the domain portion of your computer's name (which can be found by clicking on the System icon in the Control Panel). So, if the computer is looking to resolve the name "pc21" and the domain portion of your computer's name was "mycompany.com" the first query sent would be for "pc21.mycompany.com".

 The second query sent is based on the DNS suffix entered in DNS suffix for this connection (below). So, if you entered "sales.mycompany.com" in that space, your computer would also attempt to resolve "pc21.sales.mycompany.com". This query is only sent if a DNS suffix is entered in the space provided.


The local setting is used only if the associated Group Policy is disabled or unspecified.


Append parent suffixes of the primary DNS


Checking this box specifies that your computer should also send queries based on the parent domains in your computer's name (up to the second level domain). For example, if your computer wants to resolve the name "pc21" and its own name includes the domain "us.sales.mycompany.com", it would query for "pc21.mycompany.com" and "pc21.sales.mycompany.com" in addition to the standard query for "pc21.us.sales.mycompany.com".

Append these DNS suffixes


Selecting this option specifies that when attempting to resolve unqualified DNS names, your computer will formulate a query based on each of the domains listed below. For example, if your computer wants to resolve the name "pc21" and the domains "sales.mycompany.com" and "mycompany.com" appear in the list, your computer will query for "pc21.sales.mycompany.com" and "pc21.mycompany.com".

The local setting is used only if the associated Group Policy is disabled or unspecified.


DNS suffix for this connection


If you wish to specify a DNS suffix for this connection, enter it here. If you enter a DNS suffix here, it will override any suffix assigned dynamically by a DHCP server. The local setting is used only if the associated group policy is disabled or ignored.


Register this connection's addresses in DNS


Checking this box specifies that this computer should attempt to dynamically register this connection's IP address (through DNS) using the full computer name specified on the Computer Name tab of the System applet Control Panel. The local setting is used only if the group policy is disabled or unspecified.


Use this connection's DNS suffix in DNS Registration


Specifies whether DNS dynamic update is used to register the IP addresses and the connection-specific domain name of this connection. The connection-specific domain name of this connection is the concatenation of the computer name (which is the first label of the full computer name) and the DNS suffix of this connection. The full computer name is specified on the Computer Name tab (available in System in Control Panel). If the ‘Register this connection's addresses in DNS’ box is checked, this registration is in addition to the DNS registration of the full computer name. The local setting is used only if the associated group policy is disabled or ignored.


Advanced IP Settings: Protocols Tab


The Protocols tab of the Advanced IP Settings window lists additional protocols that may be used with this connection. Check the protocols that you wish to use.


Advanced IP Settings: WINS Tab


The list of WINS servers on the WINS tab will be used to resolve NetBIOS names. To add a server to the list, click Add and then enter the IP address of the desired server.
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This tab contains settings that apply to all types of Network Profiles. Some of these options may not be available if you are configuring a profile created by TelecomNZ.


Profile Name


Enter a name for this network profile. This is how it will be displayed in the Network Profiles window.


Connection Options


This setting controls what Connect Me will do when it detects the network you are configuring. There are three options:


· Select Automatic if you want the Connect Me to automatically connect to this network whenever it is detected

· Select Prompt me if you want the Connect Me to ask you whether to connect to this network each time the network is detected

· Select Manual if you only want to connect to this network manually 


VPN Auto Launch


Check this box if you would like to automatically launch your VPN client software when you establish a connection to this network.


Enable Application Launcher


If this box is checked, the Connect Me software will launch the applications displayed on the App Launcher Tray whenever it establishes a connection to the network whose profile you are configuring.


If this box is not checked, the applications in the App Launcher Tray will not be launched.


Disable IE's Manual Proxy Settings...


If you normally connect to the Internet through a proxy server (this is common on corporate LANs), you may experience difficulty connecting to the Internet with Internet Explorer when you are travelling. This is because Internet Explorer is trying to connect through a proxy server that is on your home network rather than on the network to which you are connected.


If this is the case, you may wish to disable Internet Explorer's proxy settings while you are connected to other networks. Check this box to disable proxy settings while you are connected using this profile. 


If you wish to configure specific proxy settings to be used with this connection, click the Settings button.


Launch Browser Window on Connect


Check this box to automatically launch your browser each time you connect to this network. If you want the browser to start at a particular web page each time you connect to this network, enter the address of the desired web page in the box below.
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The proxy settings window is used to configure settings for Internet Explorer that will be used only for connections via the profile being created or edited. Primarily, this window is used to specify a proxy server that will be used for the connection. A proxy server acts as an intermediary between your local network and the Internet, forwarding requests for web pages and other data from individual users to the Internet. This allows the computers on the local network to remain largely invisible to external parties, rendering those computers somewhat less vulnerable to malicious attack.


Note: Automatic settings in the top section of this window override any manually specified proxy server in the lower section. If you want to manually specify a proxy server, make sure the top two boxes remain unchecked.


Automatically detect settings


If this box is checked, your browser will automatically detect proxy servers and other configuration settings used to connect to the Internet.


Automatic configuration settings are contained in a file provided by your network administrator.


Use Automatic configuration script


Check this box if your browser should use configuration information contained in a file provided by your network administrator. The file might include settings for options such as what home page to use or configuration settings for the proxy server.


Use the Address space below to enter either the filename or a URL for the file you wish to use.


Use a proxy server for this connection


Check this box if you want your browser to use a proxy server when accessing the Internet. Then enter the address and TCP port number of the proxy server through which you wish to connect in the spaces provided.


Click the Advanced button to access more detailed settings for this proxy server.


Bypass proxy server for local addresses


Because a proxy server acts as a security barrier between your local network and the rest of the Internet, you may not actually need it when accessing other computers on your local network. Checking this box allows you to avoid using the proxy server in these cases.
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The Advanced Proxy Settings window allows you to configure detailed proxy server settings. There are two groups of settings here:


Servers


If you want to specify separate proxy servers for each protocol, enter the addresses and port numbers of the servers you wish to use here. Otherwise, check the Use the same proxy server for all protocols box.


Exceptions


Provides a space for you to type the web addresses that do not need to be accessed through your proxy server. 


If you want to connect to a computer on your local network, type its address in this box. For example, type "joe1" if you want to access a computer named joe1.


You can use wild cards to match domain and host names or addresses—for example, www.*.com, 128*, *.mygroup.* and so on.  


Connection Manager Settings
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The Settings window allows you to configure the behaviour of the Connect Me software. Among other things, these settings control how the client connects to networks, the sounds it produces and when it retrieves updates.


In the menu bar, click Options then Settings.
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The Application tab contains general settings for the Connect Me software. The following options are available:


User interface is always on top


Connect Me will always appear on top of other application windows.


Enable splash screen


Connect Me will display a splash screen while it starts up.


Automatically run this application on machine start-up


Connect Me will be launched automatically each time you start your computer.


Display connection timer


This box controls whether the connection timer will be displayed in the main window. When the box is checked (default), the timer will be displayed. When the box is unchecked, the timer will not appear.

Use this as my default Wi-Fi management utility


This box enables and disables Connect Me's Wi-Fi capabilities. When this box is not checked, Wi-Fi functionality is disabled and does not appear in the Connect Me user interface. This is useful if you have another Wi-Fi management utility that you would rather use instead of Connect Me.


Start in minimized mode


Connect Me will start in a minimized mode. Only Connect Me's System Tray Icon will be visible. Double-click the System Tray Icon to return Connect Me to view.


Hide application after connect


If this box is checked, Connect Me will hide itself once you are connected. Only Connect Me's System Tray Icon will be visible. Double-click the System Tray Icon to return Connect Me to view.


Show application on device insertion


If this box is checked, Connect Me will return to full size (after being minimized) when you attach your 3G mobile device. 


Transparency


This menu allows you to increase the transparency of Connect Me's main window.


Zoom


This menu lets you stretch the main user interface up to twice its default size.


Reset all warning messages


Connect Me provides various warning messages that can be disabled if you do not want to see them (typically, this involves checking a ‘Do not show me this message again’ box). You can turn all of these warning messages back on by clicking the Reset button.


Disable SMS Toaster


Check this box if you want to suppress the popup message that appears when you receive a new SMS message.


Settings: Connection Timeout


The settings on the Connection Timeout tab allow you to specify if and when Connect Me will automatically shut down a connection.


Configuring Duration Timeouts


A duration timeout is simply a maximum time allowed for any connection. So, if you specify a duration timeout of 30 minutes, any connection that lasts 30 minutes will be shut down.


To configure a duration timeout, check the Enable Duration Timeout box. Then, specify the number of minutes after which the timeout should occur.


If you want Connect Me to warn you before it disconnects for a duration timeout, check Display warning before timeout.


Configuring Inactivity Timeouts


Configuring an inactivity timeout instructs Connect Me to disconnect if there has been little or no data exchanged on a connection for a specified number of minutes.


To configure an inactivity timeout, check the Enable Inactivity Timeout box. Then, specify the number of minutes of inactivity that will trigger the timeout.


Settings: Hardware


The Hardware tab is used to configure hardware-related settings for establishing connections. The following items can be found on this tab:


The Device List


This four-column table takes up most of the tab's area. It is a list of all the devices connected to your computer that may be used to establish network connections. From the device list, you can:


· Enable and disable individual devices

· Choose from multiple devices of the same type

· Configure extended properties for mobile broadband devices

· Change other settings and functions for connected devices

 


Device Priority


If there are two or more devices within a technology type and Automatic is selected in the Selection column, Connect Me will choose the device that is listed first in the Device List. If that device is not currently connected to your computer, it will choose the next device in the list and so on.

To change the order in which devices are listed within their technology type, select a device whose position you wish to change and then click either the Up or Down button.


Note: This does not allow you to prioritise a Wi-Fi device over a 3G mobile device or vice versa. This type of prioritisation is done by individual network in the Network Profiles Window.


Allow simultaneous connections


If this box is checked, Connect Me will allow you to establish more than one connection at a time. (You could be connected to both Wi-Fi and 3G mobile at the same time.)


If this box is NOT checked, Connect Me will prompt you to disconnect before allowing you to establish a second connection.


Note: Some VPN connections may be seen as separate connections by the Connect Me software.  If the Allow simultaneous connections box is NOT checked, you may see a "’Multiple Connections Not Allowed’ error message if you try to make such a VPN connection.


Prompt before switching connections


When in automatic connection mode, the Connect Me software can automatically switch to a higher priority network if one becomes available. However, since the original connection is shut down once the new connection is fully established, this has the potential to disrupt any activity that was relying on the original connection.


If this box is checked, Connect Me will prompt you for permission to switch networks before it actually does so.


Profiles


Click this button to open the Network Profiles Window.


The Device List


The device list is a four-column table that appears at the top of the Hardware tab of the Settings window. It is primarily used to select and configure connected devices.

Devices Column


This column lists all the network access devices installed on your computer, grouped by the connection technologies they use. Each technology type heading is followed by the names of the specific devices of that type that are installed on your computer. The technology types are:


· Mobile Devices


· Wi-Fi Devices


· Other Devices


Note: The configuration options for the ‘Other Devices’ group are significantly different to the other groups. 

Selection Column


This column allows you to specify which devices should be used to connect. The choices for this column are:


· Automatic: Connect Me will automatically choose the best device for this technology type


· Disabled: This option is necessary for some multi-function devices that can connect to only one type of network at a time. For example, you may have a Wi-Fi/3G mobile network adapter that can't access both types of network simultaneously. When using such an adapter, you may have to temporarily shut down Connect Me's access to one of these modes when you wish to use the other mode

· Manual: You can manually select the device to be used. After selecting this option, check the box for the device you wish to use

Status Column


This column identifies the operational status of the device (on or off).


Settings Column


3G mobile devices have additional properties that may be configured. Click the Modify button that appears in this column to configure those additional properties. This opens the Device Properties window. 


Other Devices


Unlike other categories in the device list, Other Devices lists devices that are NOT supported by Connect Me. Although Connect Me cannot use these devices to establish connections, it can detect when a device in this category has established a connection and (if you desire) shut down its own connections when this occurs. 


To monitor the connection status of a device in this group, check the box in the Selected column. If you want Connect Me to shut down its own connections when one of these devices establishes a connection, make sure the Other Connections profile in the Network Profiles Window has a high priority.


The Automatic/Manual/Disabled dropdown menu at the top of the Other Devices group must be set to Manual to change which devices are checked. This menu also determines the default state of the checkbox for newly-detected devices:


· If the dropdown is set to Automatic, new devices added to the other group will be checked by default

· If the dropdown is set to Manual, new devices will be unchecked by default

Device Properties Window


This window contains additional configuration for 3G mobile devices. 


Network Selection


The settings in this section control how Connect Me selects which wireless network to connect to when you are travelling internationally.


· Automatic: instructs Connect Me to automatically select the best network to connect to, based on information provided by TelecomNZ. In most cases, this will provide the best connection available. This option is strongly recommended for all but the most advanced users

· Manual: instructs Connect Me to always connect to a specified network regardless of the availability of other wireless telephone networks. This is useful if you know of a specific network that always provides you better service and you are willing to put up with occasional service outages when the specified network is unavailable

Note: When manually scanning for networks, Connect Me currently displays all mobile networks in the area. Some networks displayed may not allow you to connect. For this reason, manual network selection is not recommended at this time.


Roaming Selection


The selected option here dictates whether Connect Me will attempt to establish connection to a roaming network:

· Always: Connect Me will always connect to roaming networks if the home network is not available

· Prompt: Connect Me will prompt to confirm before it attempts to connect to a roaming network

Connection Type


This group determines which software interface Connect Me should use to communicate with your 3G mobile device.


· NDIS allows more efficient communication with devices that support it

· RAS is supported by more devices

Note: Many devices support only one of these interfaces. If this is the case with your device, the interface that your device supports will be selected by default and you will not be able to change the selection.


 XE "Sound Settings" \* MERGEFORMAT 

 XE "Settings:Sounds" \* MERGEFORMAT 

 XE "Settings" \* MERGEFORMAT Settings: Sounds


The Sounds tab allows you to configure Connect Me to play a sound when various events occur. You can also specify the sounds that Connect Me plays. To enable this feature, check the Enable sounds box. Once the feature is enabled, checking the box for an event you wish to associate with a sound, and then click Browse to select the sound file that you wish to play (a Windows .WAV file). You can specify sounds for the following events:


Connected


When Connect Me successfully connects to a wireless network.


Lost Connection


When Connect Me disconnects from or loses its connection to a wireless network.


Hotspot Authentication


When Connect Me associates with and connects to a Wi-Fi hotspot.
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The Updates tab allows you to specify how often (if ever) Connect Me attempts to retrieve updates to its software and its databases.


Update Now


Clicking this button results in Connect Me immediately checking for available updates. If new updates are available, an update wizard will appear. This wizard allows you to choose which updates you want to download and install.


Apply Firmware Update


As part of its update process, Connect Me can download updates to your 3G mobile device's firmware. Normally, such an update will be installed as soon as it is downloaded. In some cases, however, you can choose to defer the update's installation until later. Click Apply Firmware Update to install an update that you had earlier chosen to defer.


Note: This button does not appear unless you have uninstalled firmware updates for your current device.


Automatically download and install


Select this option to have Connect Me automatically download and install product updates at regular intervals.


Note: Automatic updates are silent. You will not see the update wizard when updates are downloaded silently.


Prompt me to download and install


Select this option and enter an interval if you would like Connect Me to periodically prompt you to download and install product updates.


Manually download and install


Select this option if you want product updates to be downloaded only when you click the Update Now button.
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The VPN tab specifies how Connect Me accesses Virtual Private Networks. The top item, Do not use VPN, disables Connect Me's capacity to log into VPNs. This is the correct setting if you do not wish to establish connections to VPNs.


You must choose one of the other two options and fill in the corresponding fields if you want Connect Me to automatically launch your VPN client software connection to specific networks. See Automatically Launching a VPN Connection for more about the VPN auto-launch feature.


Use existing VPN profile


Select this option if the VPN client software you will be using is supported by Connect Me. Then, specify the supported VPN client software and the Login Profile that you want to use.


Use third party VPN client


Select this option if the VPN client software you will be using is NOT supported by Connect Me. Please read Using a Non-Supported VPN Client carefully and follow the configuration instructions when using an unsupported VPN client.


Auto Launch


Check this box if you want new network profiles created to automatically launch the VPN software specified above each time you connect. Note that this is only a default. You can change this setting for an individual profile by checking or un-checking the VPN Auto Launch box on the General tab of the properties for the desired profile. See Automatically Launching a VPN Connection for more information.


Troubleshooting


By Error Number


Windows Numbered RRAS Errors Overview


The numbered errors that are displayed by Connect Me indicate that the Routing and Remote Access Service (RRAS) component of Microsoft Windows is having difficulty establishing or maintaining a 3G mobile connection set up by the Connect Me software. These errors are actually reported by the Windows Operating System. Connect Me merely displays them when they are received.


For troubleshooting instructions for the errors that are most commonly seen in Connect Me, find the appropriate error number below.

 


Error 619


This error is typically reported when attempting to connect to a 3G mobile network. It indicates a failure during the call setup.


Possible causes


· Network resources are unavailable


· Attempting to reconnect before your device has finished disconnecting from a previous call


· Your device may be malfunctioning


Resolution


Click the Cancel button in the main window and wait for Connect Me to display Ready to Connect. Then, try again. If you are still unable to connect, follow the steps below.

· Disconnect the 3G mobile device or tethered handset from your computer

· Restart your computer, while your computer is restarting:


· If using a tethered handset, power-cycle the device.


· If using a 3G mobile device with an external antenna, make sure the antenna is connected properly

· Open Connect Me and attempt to connect

· If you are still unable to connect, contact Technical Support

Error 628


The connection was terminated by the remote computer before it could be completed.


Possible causes


· Call was dropped due to poor signal


· Call was dropped due to network congestion


Recommendation


· If indoors, move closer to a window, exterior wall or a higher level. Reorienting the computer or wireless device may help as well

· Wait 30 seconds and try to connect again

Error 630


Using a Phone Handset as Your Wireless Device


This error is typically reported when your phone or other wireless device has been removed or has not been properly set up. Make sure the device you are using for the current connection is properly attached to your computer. It may be necessary to verify the phone or device setup.


Using a PC Card as Your Wireless Device


This error is typically reported if:


· Connect Me has detected a hardware error in the PC Card

· The PC Card is not properly inserted. Make sure that the PC Card is secure in its slot

· The ‘Support SerialKey Devices Accessibility’ option is configured to use the COM port to which the modem is connected (see ‘Resolving Support SerialKey Devices’, below)

Try this first

· Click the Cancel button in the main window and wait for Connect Me to display Ready to Connect

· Try to connect again

· If this error appears again, turn your computer off and then back on

· Try to connect. If the error still appears, try the solutions listed below

Additional things to try


· Ensure that the modem is installed securely in its slot

· Try attaching the device to a different port (if one is available)

· Remove and reinsert the device to attempt the renegotiating of resources between the computer and modem

· Ensure that the device's drivers are shown in the Device Manager with no errors

· Query the 3G mobile device to determine if the device is operating properly. See Querying a Wireless Modem for instructions

· Shut down all FAX and PDA software and launch Connect Me again. Some examples of common applications that can cause problems with Connect Me include: Palm Hotsync, Microsoft ActiveSync, and Blackberry Desktop Manager

· Confirm and resolve any existing port conflicts

Resolving Support SerialKey Devices


For Windows XP, ensure that Support SerialKey Devices is not configured with the modem COM port:

· Click Start

· Select Control Panel

· Select Accessibility Options

· Click the General tab

· Uncheck the Use Serial Keys box

Error 631


This error is typically seen if you disconnect or cancel a 3G mobile connection prior to authentication occurring. In this case, the application is merely informing you that it did not expect you to disconnect at this stage. However, there is no actual failure. You should be able to reconnect at any time.


Error 633


Either the drivers for your wireless device are not functioning properly or some other program is locking the device.


Try These Quick Solutions First


· Try shutting down and unplugging the computer for one minute. Restart the computer and try to connect again

Note: If you are using an external wireless device to connect and that device has a separate power cord, once the computer has shut down, unplug the wireless device for one minute, plug the device back in, then turn on the device and restart your computer before attempting to connect again.


· Shut down all FAX and PDA software and launch Connect Me again. Some examples of common applications that can interfere with Connect Me include: Palm Hotsync, Microsoft ActiveSync, and Blackberry Desktop Manager

· Uninstall any other software that manages wireless connections, if present on the computer

Diagnosing More Complicated Causes


If the problem persists, query your 3G mobile device to see if it is responding properly. See Querying a Wireless Modem for instructions.


Error 634


This error is typically reported if an unexpected error has occurred while connecting to a Mobile network.


Follow these steps to resolve this error:

· Verify that there is no default dialup connection selected in the Control Panel

· If you are still unable to connect, shut down your computer. Then, restart your computer and the Connect Me software

· Try to connect again

· If you are still unable to connect, reinstall the drivers for your wireless device. Refer to the user manual for your wireless device for instructions on reinstalling the drivers for your device and/or obtaining updates for the device's drivers

· If you are still unable to connect, your device may not be properly configured for data access. Contact TelecomNZ Technical Support

Error 635


This error may be reported if an unexpected error has occurred while you were connected to a 3G mobile network.


Resolution


· Click the Cancel button in the main window


· Optimise your signal strength: If indoors, move closer to a window, exterior wall or a higher level. Reorienting the computer/wireless device may help as well

· Wait for Connect Me to display Ready to Connect

· Try to connect again

Error 651


This error indicates a problem with the hardware driver being used. This error can manifest itself in two unique situations:


· An appropriate driver has become corrupted, or


· You are attempting to use an old driver with a modem firmware that requires a newer driver.


Resolution


 

· Disconnect the modem from your computer

· Uninstall and reinstall the driver hardware. Refer to the user manual for the device for instructions

· Verify that the device is installed correctly and it is responsive. See Querying a Wireless Modem for instructions

· Attempt to connect

· If the issue persists, download and install the latest version of Connect Me

· If the error still persists, contact support personnel for the device or Connect Me Technical Support

Error 668


This error indicates that the network connection was dropped.


Possible Causes


·  Poor signal

· Network congestion

· You attempted to connect with a 3G mobile device that has not yet been activated

· Incorrect or missing Network Profile

Try These Solutions


· Optimise your signal strength: If indoors, move closer to a window, exterior wall or a higher level. Reorienting the computer/wireless device may help as well

· Reboot your computer and try again

· If your 3G mobile device has not yet been activated, contact Technical Support to activate it now

· Ensure that your 3G mobile data plan includes the type of access you are attempting. For assistance with rate plans, contact Technical Support

Advanced Troubleshooting

· Verify that the correct Network Profile is being used in Connect Me

· If no Network Profile is present, create a new profile, and then attempt to connect (see Creating a Profile for a 3G Mobile Network)

· If the issue persists, uninstall and reinstall the device drivers for the device. See the user manual for the device for instructions

· If you are still unable to connect, contact Technical Support

Error 678: There is No Answer


If you have previously established connections successfully using the same wireless device and connection profile, this problem is most likely because the device that answers your data call is temporarily out of service. This is a network problem, and it will most likely be addressed by TelecomNZ shortly. Select a different connection profile to connect or try again later.


If you have not previously established a connection with this device, it may be a problem with your 3G mobile device's firmware. Verify that your device is using the latest version operating software offered by its manufacturer. If you have an alternative method of connecting to the Internet, you may be able to find links to the latest firmware for your device at the device manufacturer's web site.


Resolution


· Refer to the user manual for your device to obtain the manufacturer’s web site address

· Download and install the updated firmware

· Reboot your computer

· Start the Connect Me client and try to connect

Error 679: Cannot Detect a Carrier


This error usually has one of the following causes:


· You are not using the correct connection profile to establish the connection or the connection profile you are using is not configured correctly. Try editing the network profile or selecting a different one

· Your device has not been properly provisioned for data access. Contact Technical Support for help

Error 680


This error typically occurs only when you are using an external wireless device (such as a phone) rather than a device that is built into your computer. It may have the following causes:


Another Program is using your Wireless Device


This error can appear if another program is already using your wireless device. Shut down any other programs that may be using your wireless device, and then try to connect.


Incorrect Device Selected in the Hardware Settings Tab

· Open the Settings window by clicking Options then Settings

· Select the Hardware tab

· Confirm that the device you are attempting to use is selected in the Selection column. (See The Device List for a description of all device options in the Hardware tab)

· If you are still unable to connect and are receiving this error, contact Technical Support

Error 691


This error may be reported if Connect Me has received an Authentication Error from a mobile network.


Possible causes


· Poor signal


· There is a problem with your wireless account credentials


Resolution

· Click the Cancel button in the main window

· Optimise your signal strength: If indoors, move closer to a window, exterior wall or a higher level. Reorienting the computer/wireless device may help as well

· Wait for Connect Me to display Ready to Connect

· Try to connect again

· If the problem persists, contact Technical Support for help with resolving credential issues

Error 692


This error indicates that there was a hardware failure in the 3G mobile device. This error is typically reported if Connect Me has lost its connection with the device.


Resolution


· Click the Cancel button in the main window and wait for Connect Me to display Ready to Connect. Try to connect again

· If this problem continues to occur, close Connect Me. Then, restart the software and try to connect again

· If the problem persists and you are using an external device rather than a device built into your computer, disconnect the device from your computer and then reattach. Verify that the device is properly connected to your computer. Try to connect again

· Ensure that any software provided by the device manufacturer, such as Nokia PC Suite or Motorola Mobile Phone Tools, has been disabled (refer to the user manual for the device). These programs can take control of the port that the device is attached to and Connect Me will be unable to connect to the device

· Uninstall and reinstall the device drivers (see the user manual for the device for instructions). Attempt to connect

· If the error persists, try resolving application conflicts

· If you are still unable to connect, contact Technical Support

Error 717


Connect Me was unable to obtain an IP address from the network. This is most likely only a one-time error.


Resolution


· Click the Cancel button in the main window

· Wait for Connect Me to display Ready to Connect

· Try to connect again

Error 718: Timeout Waiting for Valid Response from PPP Server


This error indicates that a PPP conversation was started but was terminated because the remote server did not respond within an appropriate time. This can be caused by several conditions including the following:


Temporary Glitches and Services Outages


If you have not made any changes to your wireless device or its drivers since the last time you successfully connected, the problem is most likely caused by transient issues such as poor quality of the wireless signal or a temporary service outage.


· Try connecting again. In many cases, you will be able to immediately connect. If that does not work, restart Windows and try again

· Check the signal strength indicator for 3G mobile networks in the main window. If the signal strength is low, you may need to try a different connection technology or a different network profile, or wait until you are in an area where you can get a better signal

· If you have good signal quality and trying again does not work, there is most likely some sort of temporary service outage.


Driver Issues


Although rare, it is possible that this error can be caused by a defective software driver for your wireless device. The best solution for this is simply to obtain and install the latest version of the driver from your device's manufacturer (refer to the user guide for the device).


TCP/IP Issues


This error may also occur if you do not have TCP/IP protocol enabled for the device that you are using to connect or if its TCP/IP settings are incorrect. Follow these steps to verify that TCP/IP is enabled:

· Select Control Panel > Network Properties (or Network and Dial-Up Properties) in the Windows Start menu

· Right-click the connection corresponding to your wireless device, and select Properties from the context menu that appears

· Select the Networking tab

· In the list in the lower half of the window, make sure that Internet Protocol (TCP/IP) is present and that its box is checked. If not, click its check box

· Click OK

Personal Computer Firewall Issues


Personal firewall software on your computer may be configured to block Internet access— either generally or from specific connections. Make sure that any personal firewall software you are using is configured to permit Connect Me to access the Internet.


Error 719


The PPP session was terminated by the remote machine. This is most likely due either to poor signal or to temporary service outages in the network.


Recommendation


· Optimise your signal strength: If indoors, move closer to a window, exterior wall or a higher level.  Reorienting the computer/wireless device may help as well


· Wait 30 seconds and try to connect again

· If you’re still having difficulty connecting, reboot the computer and try again

Error 720: No PPP control protocols configured


This error is typically reported if an unexpected error occurred while connecting to a mobile network.


Follow these steps to resolve this error:

· Verify that there is no default dialup connection selected in the Control Panel

· If this fails to resolve the error, shut down your computer. Then restart the computer and the Connect Me client. Try to connect again


· If this does not work, reinstall the drivers for your 3G mobile device (refer to the user's manual for the device for instructions)


· If you are still unable to connect, your device may not be properly provisioned for data access. Contact Technical Support for help

Error 721: Remote PPP peer or computer is not responding


This error is typically reported if an unexpected error occurred while connecting to a Mobile network.


Follow these steps to resolve this error:


· Verify that there is no default dialup connection selected in the Control Panel

· Restart Connect Me and try to connect

· If this fails to resolve the error, shut down your computer. Then restart the computer and the Connect Me client. Try to connect again

· If this does not work, reinstall the drivers for your 3G mobile device (refer to the user's manual for the device for instructions)

· If you are still unable to connect, your device may not be properly provisioned for data access. Contact Technical Support for help

Error 734: The PPP link control protocol terminated


This error is typically reported if an unexpected error occurred while connecting to a Mobile network, but it may also be due to poor signal strength.


Resolution


· Optimise your signal strength: If indoors, move closer to a window, exterior wall or a higher level. Reorienting the computer/wireless device may help as well

· Verify that there is no default dialup connection is selected in the Control Panel

· Restart Connect Me and try to connect

· If this fails to resolve the error, shut down your computer. Then restart the computer and the Connect Me client. Try to connect again


· If this does not work, reinstall the drivers for your 3G mobile device (refer to the user's manual for the device for instructions)


· If you are still unable to connect, your device may not be properly provisioned for data access. Contact Technical Support for help

Error 736


This error may be reported if a network connection cannot be established. This may be due to poor signal strength.


Resolution


· Click the Cancel button in the main window

· Optimise your signal strength: If indoors, move closer to a window, exterior wall or a higher level. Reorienting the computer/wireless device may help as well

· Wait for Connect Me to display Ready to Connect

· Try to connect again

Error 744


This error may be reported if an unexpected error occurred while you were connected to a mobile network.


Resolution


· Click the Cancel button in the main interface window

· Wait for Connect Me to display Ready to Connect

· Try to connect again, but this time, select a network to connect to that has a stronger signal

Error 774


This error is typically reported if an unexpected error has occurred while connecting to a mobile network.


Follow these steps to resolve this error:


· Verify that there is no default dialup connection selected in the Control Panel

· Restart Connect Me and try to connect

· If this fails to resolve the error, shut down your computer. Then restart the computer and the Connect Me client. Try to connect again


· If this does not work, reinstall the drivers for your 3G mobile device (refer to the user's manual for the device for instructions)


· If you are still unable to connect, your device may not be properly provisioned for data access. Contact Technical Support for help.


Error 777


Possible causes


· Poor signal


· Network resources are unavailable


· There is a problem with one of the wireless device drivers


Resolution


Follow the steps below to resolve this error:

· Make sure that your wireless device is properly connected to your computer

· Optimise your signal strength: If indoors, move closer to a window, exterior wall or a higher level. Reorienting the computer/wireless device may help as well

· Try to connect again

· If you still receive this error, shut down your computer

· Restart your computer and the Connect Me client. Try to connect again

· If the problem persists, there may be a problem with the software driver for your wireless device

· You may need to reset the driver for your device. Refer to the user’s manual for your device for instructions to reset the driver

· or— 


· You may need to obtain and install the latest/updated driver from the manufacturer of your device. Updated drivers are usually available to download from the manufacturer’s website

· If you have an alternative way to access the Internet:


· Refer to the user manual for your device to obtain the manufacturer’s website address

· Download and install the updated driver

· Reboot your computer

· Start the Connect Me client and try to connect

By Problem Description


Device Disabled


Any of the devices used by the Connect Me software can be disabled by Microsoft Windows. You can tell Windows to re-enable the device by following the appropriate procedure below.


Windows XP


· Open the Windows System Properties folder. The procedure for doing this depends on whether My Computer is on your desktop or in the first level of the Start menu

· If My Computer is on your desktop, right click on the icon and then select Properties from the menu

· If it is on the first level of the Start menu, select My Computer from the Start menu and then click View System Information in the left column of the window

· Select the Hardware tab

· Click Device Manager

· Locate the disabled device in Device Manager. Most devices used by Connect Me will be listed under the Network Adapters heading, but a few may be listed under Modems

· Right click on the disabled device and then select Enable from the menu

Windows Vista and Windows 7


· Open the Windows System Properties folder. The procedure for doing this depends on whether Computer is on your desktop or in the first level of the Start menu

· If Computer is on your desktop, right click on the icon and then select Properties from the menu

· If it is on the first level of the Start menu, select Computer from the Start menu and then click System Properties at the top of the window

· Click the Device Manager link in the left column

· Locate the disabled device in Device Manager. Most devices used by Connect Me will be listed under the Network Adapters heading, but a few may be listed under Modems

· Right click on the disabled device and then select Enable from the menu

No Wireless Device Detected


Connect Me will display ‘No Wireless Device Detected’ if it cannot actively communicate with the wireless device. 

Causes for this may include:


· Devices (such as wireless phones) that must be tethered to your computer with a data cable (such as USB), but are not currently properly connected. Make sure the cables for devices that require them are properly attached to both your computer and the device

· External devices (such as wireless phones) that are not currently powered on. Make sure external devices are switched on. Make sure the batteries of battery-powered devices are charged. Make sure devices that must be plugged into an electrical outlet are plugged in

· PC Card, USB, or Express Card devices that are not properly inserted. Make sure such devices are firmly seated in the appropriate slots

· The wrong device is selected in the Hardware tab of the Settings window. Ordinarily, automatic selection should be specified in the Selection column. If manual selection is specified, verify that the selected device is the device you are trying to use

· No driver or an incorrect driver installed. Ensure that the latest drivers for the device are correctly installed according to the instructions of the device’s manufacturer

Multiple Connections Not Allowed


This error message appears if both of the following conditions are met:


· The Allow simultaneous connections box on the Hardware Tab of the Settings window is not checked

· You attempted to establish a second connection while you were still connected using another technology

Note: VPN connections established by certain VPN client software (such as Checkpoint VPN) may appear to Connect Me as a second connection. In such cases, you may also see this message.


Resolution


To prevent this error message from appearing:

· Select Settings from the Tools menu

· Click Hardware

· Check Allow simultaneous connections

· Click OK

Wi-Fi Issues


Why do I keep losing my connection?


This may be due to interference caused by other devices like cordless phones, microwave ovens and other 2.4GHz band devices.


Why am I unable to connect to a signal that I can see in Connect Me?


Signal strength from the wireless access point may not be strong enough to allow reliable connections. It may not be a publicly available access point. 


Why Does Connect Me shut down Windows XP's native Wi-Fi management?


Connect Me provides significantly more powerful Wi-Fi management than XP’s native Wi-Fi engine. However, if you prefer XP’s native tool, you can disable Connect Me’s Wi-Fi management entirely. See Zero Config Wi-Fi for more information.
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How do I stop Connect Me from launching every time I restart my PC?


Follow these steps:

· Click Options then Settings in the menu bar

· Select the Application tab

· Remove the check from the Automatically run this application on machine startup box

· Click OK

Accessing the Windows Device Manager


To access the Device Manager on your computer, follow the steps below for your operating system:

Windows XP


· Open the Windows System Properties folder. The procedure for doing this depends on whether My Computer is on your desktop or in the first level of the Start menu:


· If My Computer is on your desktop, right-click the icon, and then select Properties from the context menu

or -


· If it is on the first level of the Start menu, select My Computer from the Start menu, and then click View System Information in the left column of the window.

· Select Hardware

· Click the Device Manager button

· In the Device Manager window, check to see if any device is marked with a yellow question mark. Such a question mark indicates that there is a problem with the driver

Windows Vista & Windows 7


· Display the Windows System Properties folder. The procedure for doing this depends on whether Computer is on your desktop or in the first level of the Start menu:


· If Computer is on your desktop, right-click the icon, and then select Properties from the context menu

— or— 


· If it is on the first level of the Start menu, select Computer from the Start menu, and then click System Properties at the top of the window.

· Click the Device Manager link in the left column

· In the Device Manager window, check to see if any device is marked with a yellow question mark. Such a question mark indicates that there is a problem with the driver

Correcting Default Connection Settings


Several Windows OS RRAS errors can be caused by a network connection in the Control Panel being configured as your default connection. This will prohibit you from using any other connection type.


Follow the steps below to ensure that the configurations are correct:


· Exit the Connect Me software

· Select Start > Control Panel > Network Connections (or Network and Dial-Up Connections)

· A window will appear that lists all of the network connections your computer is currently configured to establish. If any connection listed under the ‘Dial-Up’ heading includes a check mark, remove this by right-clicking that connection and selecting Cancel as Default Connection from the context menu that appears

· Click OK

· Restart the Connect Me software and try to connect


Querying a Wireless Modem


You can query a 3G mobile modem to determine if it's operating properly.

On Windows XP


· Close the Connect Me software

· Display the Windows System Properties folder. The procedure to do this varies depending on whether My Computer is on your desktop or in the first level of the Start menu

· If My Computer is on your desktop, right-click the icon and then select Properties from the context menu

· If it is on the first level of the Start menu, select My Computer from the Start menu and then click View System Information in the left column

· Select Hardware

· Click Device Manager 

· In the Modems group, locate the device that you were using when you received the error. Right-click this device and select Properties from the context menu

· Select the Diagnostics tab

· Click the Query Modem button. If the device is functioning properly, the Diagnostics tab will display a series of commands and responses

· If you receive an error that states that the modem is not responding and another application may be using the port, another application has most likely locked the device. See Resolving Application Conflicts

· If you receive any other error or no responses appear at all, your device driver is not functioning properly. Refer to the user manual for the device for instructions to reinstall or repair the driver

On Windows Vista and Windows 7

· Close the Connect Me software

· Display the Windows System Properties folder. The procedure to do this varies depending on whether Computer is on your desktop or in the first level of the Start menu

· If it is on your desktop, right-click the Computer icon and then select Properties from the context menu

· If it is on the first level of the Start menu, select Computer  from the Start menu, and then click the System Properties link at the top of the window

· Click the Device Manager link in the left column

· In the Modems group, locate the device that you were using when you received the error. Right-click this device and select Properties from the context menu

· Select the Diagnostics tab

· Click the Query Modem button. If the device is functioning properly, the Diagnostics tab displays a series of commands and responses

· If you receive an error that states that the modem is not responding and another application may be using the port, another application has most likely locked the device. See Resolving Application Conflicts

· If you receive any other error or no responses appear at all, your device driver is not functioning properly. Refer to the user manual for the device for instructions to reinstall or repair the driver

Resolving Application Conflicts


Shut down all other applications that are running on your computer and try to connect again. If you still receive this error, follow the steps below to locate the application that is locking your wireless device:

· Simultaneously hold down <Ctrl> and <Alt>, then press the <Delete> key

· Click on Task Manager

· Close each application listed in the Applications tab. To do this, select the application and then click the End Task button. Repeat as necessary until all applications except Task Manager have been removed from the list

·  Select the Processes tab

· Click the End Process button to shut down all of the processes except the following:


· Windows Explorer/Internet Explorer (designated "explorer.exe" in the Image Name column)

· Task Manager (designated taskmgr.exe in the Image Name column)

· Every program for which the User Name is "SYSTEM"

· Close Task Manager by clicking the x at the top right of the window or selecting the File menu > Exit Task Manager

· Try your connection again. If this resolved the problem, restart your computer and reconnect

· If you receive this error again either now or in the future, repeat the steps above, but this time:


· In Step 3, click the End Task button for only one program at a time

· After each time you click End Task, try your connection

When the error no longer appears, you will have identified which program was creating the conflict and know how to shut it down in the future.


Zero Config Wi-Fi


Zero Config is the Wi-Fi management utility built into Windows XP. Connect Me provides significantly enhanced Wi-Fi management capabilities, including the following:


· Automatically logging on to all of your wireless provider's partner Wi-Fi networks

· Specifying connection priority on a network by network basis, allowing dynamic roaming not only to other Wi-Fi networks, but also to 3G mobile networks (and vice versa)

· If desired, automatically shutting down your Wi-Fi connection when you establish a connection to another network technology, such as the local network at your home or office

· Configuring a VPN client, your browser, or other applications to be automatically launched when you connect to selected Wi-Fi networks

· In order to provide these enhanced capabilities, Connect Me must manage Wi-Fi connections itself. Since Wi-Fi cannot be managed by two different applications simultaneously, Zero Config is shut down

Note: The native Wi-Fi management tool in Windows Vista and Windows 7 is a completely different tool than XP’s Zero Config. These operating systems do not allow third-party applications such as Connect Me to shut the tool down. However, they do provide support for external enhancements. This allows Connect Me to provide almost as much functionality on Windows Vista and Windows 7 as it does on XP, without actually shutting the tool down.


How do I return Wi-Fi Control to Zero Config?


Connect Me returns control to Zero Config automatically whenever you exit the Connect Me application. If you would rather use Zero Config to manage Wi-Fi connections even when Connect Me is running, you must disable Connect Me's Wi-Fi management.


· Select Options then Settings in the menu bar

· Select the Application tab

· Remove the check from the box labelled Use this as my default Wi-Fi management utility

· Click OK

Note: This procedure disables ALL of Connect Me’s Wi-Fi functionality and hides all Wi-Fi related items in the user interface.
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For information on obtaining technical support for the Connect Me software, select About from the Help menu. 


When contacting support, be ready to supply information about the version of Windows and the type of wireless device you are using as well a description of the problem you are experiencing.
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